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CONTACT INFORMATION

Company: HandEra Inc.
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Des Moines, IA 50322

Phone: (515)-252-7522
Fax: (515)-252-7525
Web: www.HandEra.com

DOCUMENT MODIFICATION LOG

Description of changes Rev. Date
Initial release 1.0 6/13/2006

Copyright © 2007 HandEra, Inc. All rights reserved. No part of this documentation may be reproduced or
transmitted in any form or by any means or used to make any derivative work (such as translation, transformation, or
adaptation) without express written consent from HandEra.

Windows CE is a registered trademark of Microsoft.

Palm OS® is a registered trademark of Palm Trademark Holding Company, LLC.

HandEra reserves the right to revise this documentation and to make changes in content from time to time without
obligation on the part of HandEra to provide notification of such revision or changes.

HandEra makes no representations or warranties that the documentation is free of errors. The documentation is
provided on an ‘as is’ basis.
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1 General Description

The WF-10020 offers complete drivers for embedded operating systems such as WinCE and Linux. Additional
security can be added to the WF-10020 by using the optional security supplicant software offered by HandEra

1.1 Features

 IEEE Std 802.11b compliant
 Simple, high speed SPI interface
 Low power design
 Bluetooth coexistence Packet Traffic Arbitration (PTA) support
 Data Rates 1,2, 5.5 11 Mbps (802.11B)
 RoHS 2006 compliant
 Support for IEEE 802.11i and WPA security enhancements
 EEProm to Store MAC address
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2 Electrical

2.1 Block Diagram
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2.2 Connector Pin out
Pin Name Type Power Domain Description
1 SPI_INT O VIN_HIO SPI Interrupt
2 SDAT21 I/O --- N SD data bit[2]
3 SPI_MOSI I VIN_HIO SPI Master Out/Slave In
4 SDAT31 I/O --- SD data bit[3]
5 SPI_MISO O VIN_HIO SPI Master In/Slave Out
6 SD_CMD1 I/O --- SD Command
7 SPI_CLK I VIN_HIO SPI Clock
8 SD_CLK1 I --- SD Clock
9 WIFI_CS- I VIN_HIO SPI Chip select for WIFI module
10 SDAT01 I/O --- SD data bit[0]
11 MODE05 I 2.85V SPI/SDIO interface selection
12 SDAT11 I/O --- SD data bit[1]
13 MODE15 I 2.85V SPI/SDIO interface selection
14 EE_CS-2 I VIN_HIO EEProm Chip Select
15 VIN_HIO PWR VIN_HIO SPI I/O Ring Power Supply
16 NC - --- NC
17 VIN_2V PWR VIN_2V Core Power Supply
18 BT_PRI3 I VIN_BTIO Bluetooth high priority traffic indicator
19 MODE24 I --- NC
20 BT_BT3 I VIN_BTIO Bluetooth arbitration signal
21 WIFI_ON I VIN_HIO Enable Module
22 BT_RXIND3 O VIN_BTIO WLAN receive indicator
23 MODE34 I --- No Connect
24 BT_WL3 O VIN_BTIO WLAN arbitration signal
25 MODE44 I --- NC
26 VIN_BTIO PWR VIN_BTIO Bluetooth I/O Ring Power Supply
27 GND PWR Ground
28 VIN_3V PWR VIN_3V Main Power Supply
29 GND PWR Ground
30 NC - --- No Connect

Table 1 - Connector Pin out

Notes:
1. WF-10020 only supports SPI, SDIO reserved for future models.
2. Not required if host stores the MAC address.
3. Optional. Used on systems with co-located Bluetooth device.
4. MODE2, MODE3 and MODE4 reserved for future products.
5. MODE0 and MODE1 must be tied low for SPI.

2.3 DC Characteristics
Symbol Parameter Min Nom Max Unit
VIN_3V Main Power Supply 3.1 - 3.6 V
VIN_2V Core Power Supply 2.25 - 3.6 V
VIN_BTIO Bluetooth I/O Ring Power Supply 1.2 - 3.6 V
VIN_HIO SPI I/O Ring Power Supply 0.9 - 3.6 V
IIN_3V Main supply current 375 mA
IIN_2V Core supply current 85 mA
IIN_BTIO Bluetooth I/O Ring current 500 μA
IIN_HIO SPI I/O Ring current 500 μA

Table 2
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2.4 Interface Selection
The pins MODE0 and MODE1 are used to select between SPI and SDIO. The WF-10020 only supports SPI,
therefore, MODE0 and MODE should be set low.

Interface MODE0 MODE1
SPI 0 0

Table 3 - Interface selection

2.5 SPI Timing Diagram
tSCK tWL tWH
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tSU_MOSI tIH_MOSI

tEN_MISO

tDLP_MISO

tOHP_MISO tDIS_MISO

SPI_CLK

WIFI_CS-

SPI_MOSI

SPI_MISO

Figure 2 – SPI Timing Diagram (SPI_MISO clocked on rising edge of SPI_CLK)

Symbol Parameter Min Typ Max Units
tSCK Period of SPI_SCK 15.0 - - ns
tWH Clock high time 7.0 - - ns
tWL Clock low time 7.0 - - ns
tSU_SS Setup time for WIFI_CS- 3.0 - - ns
tHO_SS Hold time for WIFI_CS- 0.0 - - ns
tSU_MOSI Setup time for SPI_MOSI 4.0 - - ns
tIH_MOSI Input hold time for SPI_MOSI 0.0 - - ns
tEN_MISO Output enable time for SPI_MISO - - 8.0 ns
tDIS_MISO Output disable time for SPI_MISO - - 6.0 ns

Table 4 – AC Characteristics for SPI
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2.6 Host Schematic Example (SPI)
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Figure 3 - Simple Host Example (SPI)

2.7 WLAN + Bluetooth Co-location
The WF-10020 supports the IEEE 802.15 recommended practice of Packet Traffic Arbitration (PTA) to avoid
simultaneous transmission with co-located Bluetooth devices. PTA is a system protocol that employs an arbitration
algorithm by which WLAN and Bluetooth contend for the medium. PTA is implemented using a simple four-line
interface on the WF-10020.

 BT_WL
 BT_BT
 BT_PRI
 BT_RXIND

Note: For systems that do not contain a co-located BT device, these lines can be left unconnected.

2.8 Regulatory Approvals

 FCC Part 15 Class B
 FCC Part 15.247, 15.205, 15.209 in USA
 ETS 300 328 in Europe
 CE Mark
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2.9 Performance
Receiver

802.11B 1Mbps 2Mbps 5.5Mbps 11Mbps Units
Sensitivity1 -91 -87 -83 -83 dBm

1Typical values, PER < 8%

Transmitter
802.11B 1Mbps 2Mbps 5.5Mbps 11Mbps Units
Output Power2 16.1 16.1 17.6 17.6 dBm

2Typical values, channel 6.
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3 Mechanical

3.1 Dimensions
Note: All dimensions in inches.

0.157

Figure 4 – Side View

Figure 5 – Front View
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Figure 6 – Bottom View

Figure 7 - Host to Module

WF-10020 connector: Molex 55560-0307, or Hirose DF23C-30DP-0.5V(92)
Host PCB connector: Molex 54722-0307, or Hirose DF23C-30DS-0.5V(92)

3.2 Environmental
Non-Operational Conditions:
Ambient temperature: -30°C to +125°C.
Relative humidity: 5-95%, non-condensing.

Operational Conditions:
Ambient temperature: -30°C to +85°C.
Relative humidity: 5-95%, non-condensing.
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4 Software

4.1 Platform Support
Drivers for the following platforms currently exist for the WF-10020 module.

4.1.1 Intel PXA270

 WinCE 5.0
 Linux 2.6
 MX21

4.1.2 Freescale MX21

 PalmOS 5.4
 WinCE 5.0

4.1.3 Samsung S3C2410

 WinCE 5.0

4.2 Feature Matrix
Feature Palm base

driver
Palm - Personal

security
Palm - Enterprise

security
WinCE 5.0

WEP Yes Yes Yes Yes
TKIP No Yes Yes Yes
AES/CCMP No Yes Yes No
WPA-PSK No Yes Yes Yes
EAP-TLS No No Yes Yes
EAP-TTLS No No Yes No
EAP-PEAP No No Yes Yes
LEAP No No No No
CCX No No No No
Roaming No Yes Yes (handled by OS)
PowerSave Yes Yes Yes Yes

4.3 Definitions

4.3.1 WEP

 40 bit / 64 bit encryption keys
 104 bit / 128 bit encryption keys
 RC4 encryption standard is used to encrypt data using encryption keys entered by the user

4.3.2 WPA
There are several meanings for WPA (Wi-Fi Protected Access). WPA is a commercial term developed by the Wi-Fi
consortium to add better security to legacy or WEP products. The core of WPA1 is the TKIP key management
protocol. WPA1 was designed to run on legacy wireless hardware.
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4.3.3 WP1

 TKIP – Temporal Key Integrity Protocol is used by WPA as a method to periodically generate new keys. This
helps to provide protection so that keys cannot be easily broken by surveillance. TKIP was devised to upgrade
security on existing WEP products without requiring new encryption support in hardware.

 RC4 – Encryption standard used to encrypt data using TKIP managed keys. RC4 is generally implemented in
the 802.11 chipset for speed.

 802.1X – Access Control method, used to determine if a device is allowed access to the network. 802.1X
provides a family of protocols for user authentication, including PAP, MS-CHAP, and EAP. EAP (Extensible
Authentication Protocol) does not actually perform authentication itself, but rather provides a framework for
processing higher-level authentication methods, such as TLS and PEAP. The authentication server may reside
locally in an access point, or in a remote server which communicates to the access point (and the supplicant)
through the RADIUS (Remote Access Dial Up Server) protocol.

 High-level authentication methods (EAP-methods) – Protocols such as TLS and PEAP that perform
authentication using the EAP protocol as a transport. These authentication methods often include encryption
key generation and two-way authentication (both device and network). TLS (Transport Layer Security) is a
standardized version of the Netscape security protocol SSL, and uses digital certificates for user authentication.
PEAP (Protected-EAP) is an encrypted version of EAP in which the EAP exchanges are performed in a
protected “tunnel.”

 LEAP – Cisco Light-EAP, developed before the 802.1X standard was complete. LEAP provides the same
functionality as 802.1X, with the authentication server implemented inside Cisco access points. LEAP is
considered more secure than WEP but less secure than WPA1.

 MIC – The Message Integrity Checker is used to detect tampering with packets on an active wireless link. The
MIC can also invoke countermeasures if tampering is detected, such as temporarily shutting down the network.

 WPA “Personal” usage model: WPA-PSK
 This configuration is sometimes called “WPA Personal”. PSK stands for “Pre-Shared Keys” and refers to a

manual process of initial key distribution. The word “distribution” is used because a single key is provided
to many users of the same access point. For example, a system administrator might distribute the key to
many users of a single access point. The users need to manually enter the key provided by the system
administrator into their computers through a preferences panel. Afterwards, TKIP takes over management
of the keys.

 WPA “Enterprise” usage model: WPA-EAP
 This configuration provides automatic key management using an 802.1X authentication server. This is

sometimes called “WPA Enterprise”, and requires more sophisticated infrastructure. Generally special
software such as a RADIUS Server program is required to run on a server. This software is responsible for
authenticating users.

 There are many high-level authentication/key distribution methods that can be used with WPA-EAP. The
method specified by WPA is TLS.

4.3.4 WPA2

 WPA2 (Wi-Fi Protected Access 2). WPA2 is a commercial term developed by the Wi-Fi consortium to refer to
the more generic IEEE 802.11i suite of security protocols. The core of WPA2 is the CCMP key management
protocol and the AES encryption engine.

 CCMP – Counter Mode-CBC MAC Protocol is used as a superset replacement of TKIP in WPA2.
 AES - Advanced Encryption Standard is an encryption method that is used to encrypt data using CCMP

managed keys. AES is provided by the 802.11 chipset.
 RSN – A network in which all stations use 802.11i advanced security protocol is called a Robust Security

Network. If legacy devices are allowed to connect, the network is called a TSN (Transitional Security
Network).

 WPA2 cannot be implemented on legacy 802.11 chipsets because of the required hardware AES support.
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4.3.5 CCX
Cisco Compatible Extensions(CCX) are a collection of protocols defined by Cisco for wireless security, forming a
super-set of WPA and 802.11i. In addition to authentication and encryption, CCX includes specifications for power
management, roaming, and VOIP. As of 2005 there are four different versions, each version adding extensions to the
previous version.

 V1 – 802.11, 802.1X, WEP, LEAP, CKIP (Cisco TKIP), multiple SSID support.
 V2 – WPA, roaming, power management.
 V3 – WPA2, EAP-FAST, Wi-Fi multimedia.
 V4 – PEAP-MSCHAP, voice metrics, AP-directed roaming.
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5 Appendix A: Agency Certifications

5.1 United States (FCC):
The WF-10020 802.11b Module complies with Part 15 of the FCC rules and regulations. Compliance with
the labeling requirements, FCC notices and antenna usage guidelines is required.

1
The HandEra WF-10020 802.11b Module may only be used with antennas that have been tested

and approved for use with this module. All other antennas must be tested to comply with FCC §
15.203 (Unique Antenna Connectors) and § 15.247 (Emissions) and will require a Class 2
Permissive Change or a new Certification.

IMPORTANT NOTE: In the event that these conditions can not be met, then the FCC authorization is
no longer considered valid and the FCC ID can not be used on the final product.

Co-location with transmitters other than Bluetooth model WML-C29, FCC ID: POOWML-C29XX, is not allowed.
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5.1.3 FCC Notices
This device complies with Part 15 of the FCC rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation.

Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to
Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference to
radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try to correct the interference by
one or more of the following measures:

 Re-orient or relocate the receiving antenna
 Increase the separation between the equipment and receiver
 Connect equipment and receiver to outlets on different circuits,
 Consult the dealer or an experienced radio/TV technician for help.

The use of shielded I/O cables is required when connecting this equipment to any and all peripheral or host devices.
Failure to do so may violate FCC rules.

Note: Changes or modifications not covered in this manual must be approved in writing by the manufacturer's
Regulatory Engineering Department. Changes or modifications made without written approval may void the
user's authority to operate this equipment.



Figure A-1. Required FCC Label for OEM products containing the WF-10020 802.11b Module 

Contains FCC ID: URZ-WF10020 
The enclosed device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (i.) this device may not cause harmful interference and (ii.) this device must accept any 
interference received, including interference that may cause undesired operation. 
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Introduction  
Congratulations! You now have in your hands the most powerful, flexible, and easy-to-use 
personal data assistant (PDA) available today. The fact that it has no screen and is designed 
specifically for use by blind students and professionals makes the unit even more compelling. The 
device's developers have vast experience in the field of blindness and technology and many are 
users of such devices themselves.  
      
Let's take a moment to go over the organization of this manual: Conventions used in this 
Document.   
  
This documentation represents multiple key sequences, or rather, keys that are to be pressed 
simultaneously,  by separating the individual keys with a plus sign. So, if you were asked to press 
and hold the pound key while you press the number 1, the key would look like this: # + 1. Keys 
that are to be pressed in succession, or one after another, are separated by a comma. For 
example, the keypad shortcut used to get to the RSS application from the Applications Menu is to 
press 4 followed by 3 and will appear as 4, 3.    
  

Top of Page
  

Orientation 
Input and Output Connections 
The following connections come standard on the Icon:  

• 802.11b wireless internet connectivity  



• Bluetooth connectivity  
• Stereo speakers  
• Internal mono microphone  
• Stereo microphone jack 
• 3.5 MM headphone jack  
• Mini headset  jack  
• Mini-SD card slot  
• Power connector  
• Record button  
• Speaker switch button  
• Volume control  
• Telephone keypad with additional navigation and function keys.  
• USB connection Docking Station  

      
You may also elect to purchase an optional docking station with either a braille or QWERTY 
keyboard. This docking station provides the small hand-held unit with a full keyboard, phone 
modem, Ethernet connector, USB connectivity, better stereo speakers, and 4 times the normal 
battery life. This accessory will prove especially useful to those students and professionals who 
prefer a full sized keyboard with the convenience and power of the PDA.       

Location and Definition of Buttons 
The Icon is designed for easy, intuitive one-handed operation when it's not being used in a 
docking station. You might hold it in the palm of one hand, and enter commands with the other; or 
you can easily operate it with one hand while it's on a desk or clipped to a pocket or belt in the 
included carrying case. For this orientation, place your Icon so that the keypad faces up and the 
earpiece (an oval-shaped bump with vertical ridges) is furthest away from you. We will be 
reviewing the Icon's buttons and features by surface in the following order: 

• The Front Face 
• The Left Edge 
• The Top Edge 
• The Bottom Edge 
• The Power Connector 
• The Back Face  

     
 (There are no input elements on the right edge of the Icon)      

Front Face 
The way you navigate through the Icon's suite of programs will be familiar to you if you've ever 
used a cell phone; except that every feature is accessible without a screen, and the buttons have 
been designed to be prominent and easy to tell apart. 
      
On the lower half of the front face, you'll find twelve equally sized keys grouped together. These 
make up the telephone keypad. The telephone keypad will allow you to use numeric shortcuts to 
get to any program from the applications menu; enter contact numbers; and write text.  
      
The Icon phone pad is laid out like a standard telephone keypad, and like a standard telephone 
keypad, allows for entering either numbers or letters depending on context. When you're in the 
Icon menu system, all key presses on the phone pad will be treated as digits; however, when 
you're in an application that requires text input, such as the word processor or your list of songs in 
the music player, you will press one of the 9 main number keys to get the letter or punctuation 
symbol you want. By default, you have one second between presses before the system inputs the 
letter you have selected. You may change the time Icon waits to input the character in the general 
settings section of the Utilities Menu described later in this manual. 
      



On the upper half of the face, just above the telephone keypad, there are several more buttons. 
Directly above the telephone keypad is a row of 3 keys. The corner-shaped key on the left is the 
OK button: this button agrees to any action the Icon's operating system needs confirmation to 
perform, can open a highlighted file or program, saves changes in a dialog, and answers yes to 
Icon questions. The central button, which is rectangular, is called the Program Menu button: when 
you press it within an application, you'll get a list of options relevant to the task you're working on. 
For example, in the music player application, you'll be able to access options such as Shuffle and 
What's Playing? To the right of the Program Menu button, you'll notice another corner-shaped 
key; this one is the Cancel button, and pressing it briefly will allow you to abort, or call off, any 
operation you've chosen by mistake. In addition, cancel will exit a program or menu, and answers 
no to Icon questions. A long press of about a second will turn the Icon on and off. A short tone 
and a vibration mean the unit is on; a double tone and double vibration mean it is off.  
     
The central group of buttons is shaped like a diamond and is made up of five parts. The corners 
of the diamond are the up, down, left and right arrow keys; the round button in the center is the 
select key. You'll use the arrow keys for navigating through menus and lists of options, as well as 
for navigating text in documents.  
      
In text environments, the left and right arrows move backward and forward by character; the up 
and down arrows move backward and forward by line. Holding down the up and down arrows will 
move you to the top and bottom of a document respectively. Holding down the left and right arrow 
keys will take you to the beginning or end of the current line. Holding down the 0 key while using 
the arrow keys moves in larger steps: doing so with the left and right will move by word; doing so 
with the up and down arrows will move by paragraph. Finally, holding down pound while pressing 
the up and down arrows will move you by page.  
      
In menus, the up and down arrows move through your choices. The right arrow key will open a 
submenu any time one is available: otherwise it will open the highlighted application. The left 
arrow key will return you to the previous level in a menu system.  
      
The select key will allow you to select and confirm actions such as choosing a program or playing 
a song. The Select key also stops and starts continuous reading in a text environment, stops and 
starts media playback, and toggles between pause and  recording in the voice recorder. 
      
Now, direct your attention to the top part of the arrow diamond. Flanking the up arrow key are two 
more buttons. The one on the right is the Help key - valuable for new and seasoned users alike, a 
brief press of the Help key will provide a message relevant to your current place in the system. 
For example, if you're setting the date and time, the Help key will place you in the section of the 
user's manual that lists the steps necessary to set date and time correctly. Once you're done 
reviewing the information brought up by the help key, simply press Cancel to return to what you 
were working on when you first pressed Help. A longer press, of about a second, will turn on 
KeyLearn Mode. Once you're in KeyLearn Mode, press any key to find out what it does; press the 
Help key again, for one second, to turn KeyLearn mode off. 
      
The key on the left is the Status key. Pressing it briefly will repeat the last message spoken by the 
Icon. Pressing it twice in rapid succession will yield program specific status. For example, if you 
are downloading e-mail, press status twice quickly, and Icon will tell you where it is in the 
receiving process and how far it has to go. Pressing and holding it for about a second will bring 
up the status application, where you can arrow up and down to check your battery level, the time, 
pending appointments, whether your wireless connection is on or off, and the software version 
the Icon is running. If you would like the last phrase spoken by the Icon to be spelled, press the 
status key followed by the help key.  
      
Finally, move your hands above the Status and Help keys. The last three keys on the unit are two 
dot-like keys with a bar in the middle. Whenever you find these keys at the top of the Icon, you'll 
know you're oriented in the right position. The left and right round keys are named Program Key 1 



and Program Key 2. Later, you'll learn how to set each of these to a favorite application or 
function. For example, one could start the media player, and the other could open the calendar. 
By default, a long press of Program Key 2 turns your wireless connection on and off. The central 
key on this row, a rectangular bar, is the Applications key. A quick press of this key brings up the 
Icon's main menu, from which you can access every application. A longer press will bring up the 
Icon's task manager, where you can review and manage your currently open applications.         

The Left Edge 
On the left edge of the Icon, you'll find several buttons relevant to sound input and output. 
Starting at the top, just below the left-hand speaker, you'll notice a long rocker switch. This is the 
Icon's volume control. A press of the upper part of the control will raise the Icon's volume, and a 
downward press will lower it. Unless the Icon is reading text, you will also hear an announcement 
of "louder" or "softer" as you increase or decrease the unit's volume, as well as an announcement 
of "loudest" or "softest" when you have changed the volume to the loudest or softest setting. 
      
Sometimes, you may want to control the volume of media content on the Icon without altering the 
volume of the speech output; or you may want to raise or lower the volume of speech but keep 
the media volume the same. Hold down the star key while raising or lowering the volume to 
control only the volume of the speech output. When you do this, you will still get the audible 
announcement of "softer" or "louder" as long as the Icon is speaking text. Hold down the 0 key 
while raising and lowering the volume to control only the volume of media content. When you do 
this while media is playing, you will get no announcement by way of confirmation, but you will be 
able to hear the media getting louder or quieter. If you change the media volume while no media 
is playing, you will hear a set of beeps, low to high while the volume is being increased and high 
to low when it is being decreased.  
      
Directly underneath the volume control, there is a round button that toggles the Icon's audio 
between the external speakers and the earpiece mounted above the keypad. When you have 
headphones plugged into the Icon, this button will have no effect. Toggling between the speakers 
and the mounted earpiece allows you to choose between a robust stereo sound and a private 
listening experience. The earpiece is especially handy if you need to jot down a quick note or look 
up a phone number while you're in public and headphones are inconvenient. 
      
You'll find one more button below the speaker/earpiece toggle, separated by a small ridge. This 
lowest button is called the Quick Record button. Later, you'll learn how to manage the file names, 
quality and storage locations of your recordings, but the Quick Record button allows rapid audio 
capture without any prior setup. Just press it for about two seconds to start recording, and then 
press Cancel to stop. All files recorded this way are saved in a mono, low-bitrate format suitable 
for up-close voice recording. They are automatically tagged with the time and date they were 
taken, and saved to the Recordings folder of the Icon's internal flash disk.      

The Top Edge  
The top edge of the unit contains three audio jacks and a Mini-SD slot. The left-most jack accepts 
cables from external microphones. The Mini-SD slot is located at the center of the top edge just to 
the right of the microphone jack. You can buy Mini-SD cards for this slot that will expand the 
Icon's onboard storage and allow you to swap data with the owners of other SD-compatible 
devices. The headphone jack is located just to the right of the Mini-SD slot. It accepts standard 
3.5MM headphone jacks, so you can continue to use your favorite pair of headphones with the 
Icon. The third jack on the top edge of the unit is a sub-mini headset jack and accepts 
combination microphone/headphone headsets typically used as accessories with mainstream cell 
phones. This type of headset is ideal for making verbal notes while you're using the Icon      



The Bottom Edge 
On the bottom edge of the unit and toward the left side, there is a textured slide switch. This is 
your Keypad Lock. Normally, it should be in the left position, so that you can use the keypad to 
type. If you want to lock your keypad to avoid accidental key presses, slide this switch to the right, 
and the unit, if it is on, will announce "keypad locked". Sliding this switch back to the left will 
cause the unit to announce, "Keypad unlocked". If you find that your Icon doesn't seem to be 
receiving key presses, it's a good idea to check the Keypad Lock switch to make sure it's in the 
left side position.       

Interface Connector  
The center portion of the bottom edge contains the connector into which you plug your 
power/sync cable. This cable is used for three purposes:  
•         charging the battery,  
•         connecting the unit to your PC,  
•         and connecting other USB devices to the unit.      

  
The cable contains a flat connector with releases on the left and right to help keep the connecter 
attached. One side of the connector is completely smooth, and the other side has an inlaid 
rectangle that contains some embossed text. The side with this textured rectangle should be 
facing up when you plug the connector into the Icon. Since the connector to the cable contains 
several fairly delicate pins, it is important to check that the connector is being inserted properly, 
and it should connect without the need for much force. Press in on both releases when you want 
to disconnect this cable from your Icon.  
      
A short cable runs from the bottom of the connecter and ends in a box that contains three ports. 
On the bottom edge are a USB client and a USB host; on the top edge, to the left of where the 
cable exits the box, is the alternating current (AC) connecter into which you plug the wall unit to 
charge the device's battery. Remember that the Icon can charge itself through your PC'S USB 
port, so the AC charger is necessary only when you don't have a PC connection available or 
when it is more convenient to use the Icon for long periods of time away from your PC (for 
example, if you've integrated it into your home stereo system).      

Battery Care and Use 
Your Icon uses a lithium-ion battery with a rating of 1700 milliamp hours. Given this power level 
and the typical usage patterns and the power consumption of the unit, you may expect to get 
about six to eight hours of steady use from the device when the wireless radio is off and about 
three to four hours of usage with the radio on. Expect about four times this battery performance 
when using the batteries in either of the docking stations. If you need more time away from AC 
power, you may consider purchasing an additional battery and use it to supply another charge 
when the first battery's charge fades. To change batteries, power the unit off, change the battery, 
and turn the power back on. It's a good idea to have the replacement battery ready to insert 
before removing the current battery, as you have only about 45 seconds to make the change 
before the clock settings are lost. 
      
Warning 
      
Do NOT remove the battery while the Icon is running. Removing the battery while the unit is 
running is strongly discouraged by the manufacturer. Removing the battery while your Icon is on 
may cause data loss, data corruption, and loss of the clock settings.       

Resetting Your Icon 
In the rare instance that your unit locks up or begins to act strangely, you may need to reset. To 
access the reset button, you need to remove the battery compartment door, locate the deep 
round recess that contains the reset button, and press it with a small object such as a stylus or 



the jack end of your ear buds. The hole containing the recessed reset button is located at the top 
left side of the battery compartment on the wall between the battery and the left side of the case.  
You will know that your reset has succeeded when you feel the Icon emit a short vibration. Wait 
between 20 and 30 seconds, and you should hear the message, "Welcome to the Levelstar Icon", 
followed by the announcement "Applications Menu". Once you hear this announcement, the Icon 
is ready for you to resume working.     
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The Icon Application Environment 
Your Icon provides several generalized utilities for manipulating the overall environment. These 
include 
•         The Applications Menu 
•         The Task Manager 
•         The Information and Status Center      

Applications Menu 
The first time you turn on your Icon, and any time thereafter when power has been lost or the unit 
has been reset, you'll know the Icon is ready to work when you hear the words "Applications 
Menu". You may access the Applications Menu at any time from anywhere on the unit by briefly 
pressing the Applications key on the top center of the keypad.  
      
The applications menu provides easy access to any of the unit's applications. Use the Up Arrow 
and Down Arrow to browse through the list of applications the menu has to offer. Pressing select 
on some of these options, such as the music player, will take you directly into the application. 
However, when an option is followed by the word "menu", you'll know that pressing select will 
bring up a list of options in that category. For example, the fifth option, "tools menu", contains 
both the word processor and the planner, among other tools. You can explore these menus 
without opening any applications; when you're ready to back out to the previous menu, press your 
left arrow key. If you wish to open a program, press Select or OK.  
      
The Icon is designed with some very efficient numeric shortcuts that will let you jump straight to a 
particular application. As you arrow through the Applications Menu, you'll notice that each item is 
associated with a number: you'll hear "1 - address book", "2 - music player", and so on. Pressing 
the number associated with any of these items will open the application or menu immediately, 
with no need to arrow directly to it. For example, from the Applications menu, you can press 5 for 
Tools, then 1 for Word Processor, and the word processor will open immediately. Similar 
shortcuts are also available in program specific menus. continuing with the example of the word 
processor, if you would like to navigate to the top of the document, you may press the program 
menu key followed by 93 in quick succession; 9 takes you to the navigation menu, and 3 will get 
you to the start of the document.      

Task Manager 
Sometimes you may be performing more than one task on the Icon: for example, you might be 
writing E-mail while music plays at a low level in the background. To switch among the Icon's 
currently open applications, you should use the task manager. 
      
You can access the task manager by holding down the Applications Menu key for about a 
second. When the Task Manager is loaded, the Icon emits a beep similar to the one you hear 
when turning on the unit, and then announces "Running programs" followed by the first running 
program in the list. The up and down arrow keys can be used to navigate among all running 
programs. If you'd like to switch to one of the programs in the task manager, simply navigate to 
that program and then press select. 



     
 Pressing the Program Menu button when a running program is highlighted brings up a list of 
three options. Option 1, Switch To ..., performs the same function is pressing select on a 
program. Option 2, Stop ..., will halt the application you have highlighted. Option 3, Refresh, will 
update the list of programs running in the task manager to reflect any recent changes. 
      
Caution: Stop Programs with Care 
      
Although you can stop any application from the task manager, stopping a program is different 
from closing it. When you close the word processor, for example, you are given an opportunity to 
save your document. When you stop the music player, the Icon will allow you to resume playing 
right where you stopped. When you stop a program from the task manager, the application is 
unloaded immediately, and information accumulated since the last time you ran the program may 
be lost. 
      
In practice, it's best to stop an application from the task manager only when you find that that 
application is behaving in an unstable manner, or when you're running too many concurrent 
applications and your Icon becomes too sluggish. To avoid the potential data loss inherent in 
stopping programs, try to avoid running more than three programs concurrently.      

Information and Status Center 
Once you learn the layout of the keys, one of the first things you may wish to do is access the 
time, date and battery level of your Icon. You will do this from the Information and Status Center, 
which you can access by holding the Status key down in a long press of about a second. When 
you release the button, the unit will place you in the Information and Status center, where you can 
review information about battery status, network connections, appointments, and the date and 
time. Each of the options pertains to specific information about your Icon. As with any menu in the 
system, you may use the Up Arrow and Down Arrow keys to move from option to option in the 
menu. The order of items in the status center, by default, is the same as the order in this manual: 
•         Time and Date 
•         Battery Status 
•         Appointments 
•         Wireless Status 
•         Icon Software Version 

      
You can press the Program Menu key while positioned on any of the items in the Status Center to 
bring up a list of options relevant to that item, and although some of these options differ, every 
item has the options "move up" and "move down". Selecting "move up" positions the current item 
above the one that comes before it; and selecting "move down" moves the current item past the 
item below it. If an item is at the beginning of the list, "Move up" will not be available; and if an 
item is at the bottom of the list, "move down" will not be available. You may also press select on 
the time and date, the appointment notification, and the wireless status to access the clock 
settings, the planner, and the wireless control panel respectively.      

Time and Date  
By default, the first item in the Information and Status Center is the date and time. You may use 
this information to check the current date and time from any place in the unit. To set the date and 
time, you should first bring up the Information and Status Center by pressing the Status button for 
about a second. The unit will announce "status", and then read whichever item within the 
Information and Status Center is currently selected.  
      
Use the up and down arrow keys to find the line which reads the date and time. You may simply 
press select to bring up the clock settings or press the Program Menu key, just under the arrow 
diamond, to open the Clock menu. The Icon should respond "1: set time and date." This means 
that you're in the clock options menu and on the correct option, so just press select. You will be 



prompted to select the time format you prefer. Choose between 12-hour (AM/PM) time and 24-
hour (military) time with your left and right arrow keys. When you have chosen the time format 
you want, press down arrow, and you will be presented with the current selected time zone.  
      
If you wish to change the time zone, press select. You will then be presented with a list of 
countries. Arrow down to the country you want, or press its initial letters on the phone pad (for 
example, press the 2 key three times in rapid succession for the C in Canada). When you have 
chosen the country you want, press select again, and you will be presented with a list of time 
zones within the selected country. Arrow down to the one you want, and press select once more 
to return to the Set Time and Date main screen. If, at any time, you select a country in error, use 
the left arrow key to back up a step.  
      
After choosing the time zone you prefer, arrow down once more, and you will be prompted to 
enter the current time as a four digit number. If you are setting 24-hour time, simply enter two 
digits for the hour, then two for the minute. If you're entering 12-hour (AM/PM) time, enter the two 
digits for the hour, then two for the minute, and then use the pound key to toggle between AM 
and PM. When you're done, press the down arrow key again. 
      
You are now ready to enter in the date. Enter it as an eight digit number in the format mmddyyyy. 
This means that you should first enter two digits for the month; then two for the day; and, finally, 
four for the year. For example, to enter March 3, 2007, enter "03032007". Once you have done 
this, press the OK button, and the unit will respond "Time and Date Set."  
      
If you have a working connection to the Internet, either through your wireless connection or the 
USB cable, you can choose to bypass these manual steps and have the Icon retrieve the time 
and date automatically from the Internet. To do this, follow the same steps as described above to 
enter the Set Time and Date screen, but instead of manually filling in all the fields, choose your 
desired time zone as described above, then arrow down to "Retrieve time from the Internet" and 
press OK. The Icon will say "Synchronizing" and will attempt to synchronize with a time server on 
the Internet. If it is successful, it will say Okay and then read the time. If it responds that it was 
unable to connect, you will know that your Internet connection is not working properly, or that you 
are not connected at all. This feature is great for ensuring that you never run five minutes too fast 
or too slow, and also for checking, quickly and simply, whether your Internet connection is 
operational.      

Battery Status 
Below the display of time and date in the Information and Status Center, you will find your Icon's 
current battery level. Remember that your Icon should perform for between six and eight hours 
per charge with the wireless radio off, and three to four hours when the wireless radio is on. The 
battery level is expressed as a percentage, and may be erratic for the first minute or so after you 
turn your wireless radio on or off. Start looking for an alternate source of power when your battery 
level dips below 20 percent; and remember that, at 5% of full battery capacity, your Icon will 
automatically switch off. The Icon does this to maintain a sufficient charge to keep your clock 
settings and other preferences intact until you can recharge the unit.      

Appointments 
Below the battery level, you will find a line that displays what appointments, if any, you have 
scheduled on any given day. If the Icon finds no appointments for the day, it will announce "You 
have no more appointments for the rest of the day." If you have one ore more upcoming 
appointments during the day, the Icon will display the one that is chronologically coming first. By 
pressing Select on the appointment line, you will open your planner to the current day, and from 
there you can review all your other appointments.      



Wireless Status 
Beneath the appointment line, you'll find a status line that describes whether your wireless radio 
is on or off. In addition, if your wireless radio is on, the Icon will announce whether it is connected 
to a network and, if so, the strength of the wireless signal. Remember that you can toggle your 
wireless radio on and off with a long press of Program Key 2, located at the very top right of the 
Icon keypad. If you are connected to a network and would like details about your current wireless 
connection, press the program menu key while the wireless status item is highlighted, and select 
wireless details.      

Icon Software Version 
The very last item in the Information and Status Center is a line describing which version of the 
Icon software is running. This information will be important whenever you call technical support, 
and will help you to confirm whether software updates to the system have been successful.     
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Input Techniques 
Icon offers a variety of ways to enter text and numbers. You may use the telephone keypad, an 
external QWERTY keyboard, or a docking station with a braille or QWERTY keyboard.      

Telephone Keypad 
The telephone keypad lets you type characters or numbers in an application. Depending on the 
specific application in use, the keypad may be in numbers mode, braille mode, or in letters mode. 
Each of these keypad layouts provides alternate ways to type text. 
      

1 2 3 
4 5 6 
7 8 9 
* 0 # 

  
You may alternate among the keypad layouts by holding down Pound while pressing the Program 
2 key.      

Numbers Mode 
When an application requests information from you that consists of numbers, it lets you type the 
numbers directly. So, if you wanted to enter the date as 08152006, you would type those 
numbers on the keypad.      

Alpha Numeric Mode    
Many applications expect letters rather than numbers. If you were writing an email, for example, 
most of the characters you type would be letters, but there would be occasional need to type a 
punctuation character or a number. Alpha numeric mode of the telephone keypad lets you 
accomplish just that. Here is how it works. 
     
Each key has numbers and letters printed on it. To type the second or third letter on a key, press 
that key a second or third time within a short amount of time. If you wait too long, the PDA will 
accept the character and the next time you press that same key, the unit will give you the first 
letter in the series. 
      



You may still type numbers even when the keypad is in alpha numeric mode. The number 
associated with a key is usually the fourth press of the key. There are exceptions for the numbers 
7 and 9 as each of these has 4 letters associated with it. 
      
So, when you press, for instance, the 2 key once, you get the letter A. A second press yields B, 
and a third produces C. A fourth press produces the number 2. You may type capital letters of A, 
B, or C by pressing the 2 key a fifth, sixth, or seventh time. 
       
Pressing the 1 key will allow you to text the following punctuation marks and the number 1 in this 
order: dot, at, slash, colon, 1, question mark, line, and equals. . The 2 represents, in order, A, B, 
C and 2. The 3 represents D, E, F and 3. The 4 represents G, H, I and 4. The 5 represents J, K, L 
and 5. The 6 represents M, N, O and 6. The 7 represents P, Q, R, S, and 7. The 8 represents T, 
U, V, and 8. Finally, the 9 represents W, X, Y, Z, and 9. 
       
The * or star key is called the Splat key. Press Splat to delete the character to the left of the 
cursor or, in some program specific lists, to delete the highlighted item. The 0 key works as a 
space bar, and if pressed repeatedly, will also yield 0 and plus; the # or pound key, to the right of 
the zero, brings up navigation options in text-based applications.      

Modifier Keys 
In addition to typing normal letters and numbers on the telephone keypad, you may also use the 
three keys at the bottom of the telephone keypad as modifier keys. The * keys serves as the shift 
key, 0 acts like Control, and # is the Alt. So, to press Alt+B, press and hold down the # key then 
press the 2 key twice (once for A and once for B).           

Braille on the Telephone Keypad 
In addition to number and alpha-numeric modes, Icon offers Braille input using the standard 
telephone keypad. 
      
If you are familiar with braille, this is an effective means of entering a large amount of text in a 
short amount of time. If you aren't familiar with the braille code, you may wish to invest some time 
learning it; it will save you a lot of keystrokes in the long run. 
      
The left row of keys on the telephone keypad represents the left row of dots of a braille cell. The 
digit one serves as dot one. The digit four serves as dot two. Seven is dot three. Similarly, the 
right most row of keys acts as the right half of the braille cell. Dot 4 is produced with the number 
three. The number six produces dot five, and nine produces a dot six. The pound sign (bottom 
right) is the Space. 
      
To make a letter that requires more than one dot in braille, hold down the desired keys all at 
once. So, to make the letter l which is represented in braille with dots 1, 2, and 3, you would press 
the telephone numbers 1, 4, and 7, the three keys on the left side of the telephone keypad. 
      
To make a capital letter, press Star before making the desired letter. 
      
The bottom three keys of the telephone keypad, the Star, 0, and Pound, act as modifier keys just 
as they do when texting.      

Thumb Braille 
Once you use the telephone keypad to enter braille, you soon notice that multiple dot characters 
may become difficult to press, especially with two fingers or your thumbs. The primary cause of 
this problem is trying to press more than two non-adjacent keys on each side of the braille cell. In 
other words, pressing dots 1 and 2 at the same time is easy to do with one finger or thumb, but 
pressing dots 1 and 3 or 1, 2, and 3 all together is problematic. 



      
It is for this reason that thumb Braille exists. Thumb Braille takes the four keys in the middle row 
of numbers and assigns them the four combinations of non-adjacent dot combinations. The 
combination of dots 1 and 3 is entered by pressing 2. The number 5 produces dots 1, 2, and 3. 8 
produces dots 4 and 6. 0 produces dots 4, 5, and 6. 
      

2 1 3 5 1 2 3 8 4 6 0 4 5 6 
  
Now, to type the letter l, just press key digit 5. To produce p, press 5 and 3 together. The 5 gives 
you dots 1, 2, and 3, and the 3 gives you dot 4. 
      
To type Space, press #. 
      
To press Enter, use # and * together. 
      
Press * once to indicate the following character is capitalized. Press and hold * to engage Caps 
Lock. Press and hold again to turn off Caps Lock.      

Other Keys 
To make Escape, press Star+1. 
      
To make Tab, use Star+2. 
      
To make Backspace, use Star+3. 
      
The next two rows of three keys are easy to remember, because they mimic the arrangement of 
the six keys normally grouped together on a traditional keyboard, often referred to as the 6-pack. 
      
Insert is Star+4. 
      
Home is Star+5. 
      
Page Up is Star+6 
      
Delete is Star+7. 
     
End is Star+8. 
      
Page Down is Star+9. 
      
Esc 
     
Tab 
     
Backspace 
     

Function Keys 
Hold down # while pressing the numbers 1 through 0 to get F1 through F10.  
   
External Keyboards: In addition to the built-in phone pad on the unit for entering text, there are a 
number of external keyboards that will work well with the Icon. The most basic of these, the USB 
keyboard, plugs into the USB client port on the power/sync cable that comes with the Icon. You 
can also choose to use a Bluetooth keyboard wirelessly with the Icon. See Appendix B for a list of 
qwerty commands.      
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The Address Book 
Now that you've become acquainted with the Information and Status Center and how to enter and 
navigate text, you'll probably want to start exploring the applications that make the Icon so 
versatile and powerful. The Address Book is a good place to start. As with starting any 
application, your first step should be to press the Applications key to bring up Icon's main menu. 
The unit will announce, "Applications menu". At this point you may either arrow down once, hear 
the announcement "1: address book", and press select; or you may simply press the number 1. 
Since option 1 is the Address Book and it contains no submenus, pressing 1 from the 
Applications Menu will always take you directly to the address book.      

Adding New Contacts 
When you open the address book, you will automatically be positioned on the list of contacts 
currently saved. If there are none, you will hear the prompt "addresses: empty list." To add an 
address, press the Program Menu key, and then select the first option you hear, "1: New 
Address". You will be prompted to enter a first name. After you have done so, down arrow to the 
next field, "middle name", which you may either fill in or leave blank. You may continue down the 
list of contact details, which include street address, street address line 2, city, state, zip code, 
home phone, work phone, cell phone, webpage, and comments, entering information for each 
field or leaving it blank according to your preference. The last item in the list of details to be filled 
in is "E-mail addresses" and, rather than simply typing in an E-mail address for your contact, you 
must first press Select on this item.  
      
Once you press Select on the E-mail Address line, you will be presented with a list of E-mail 
addresses currently saved for the contact. If you are creating rather than editing the contact entry, 
this list will be empty. To add an E-mail address, press the Program Menu key, then select "New 
E-mail address". You will be prompted to give the "real name" of your contact. This means the 
name that is associated with the E-mail account you are adding. You may choose to fill this item 
in or leave it blank. When you arrow down, you will be prompted to fill in your contact's E-mail 
address. Arrow down once more, and you can choose whether the E-mail address you are 
adding will be the default for future correspondence with this contact. Press Select to toggle 
between "yes" (this E-mail address will be the default for your contact) and "no (this E-mail 
address will not be the default.) When you're finished, press OK to return to the main details for 
your contact, and press OK again to save your entry and return to the list of addresses in the 
address book.      

Reviewing and Editing Your Contacts 
Once you have created some contacts to browse, they will appear in the "Addresses" list in your 
address book. To review the information contained in a contact's entry, just press Select on the 
contact and the entry will open. You can navigate among the fields with your up and down arrow 
keys. Repeat the contents of any line by pressing Status, and use standard editing commands to 
change the information on any line. When you're done, press OK to save any changes and return 
to your list of Contacts or press Cancel to return to the list without saving any changes. 
      
If you would like to delete an entry from your contacts, arrow to the contact you want to delete 
and press the star key. The Icon will ask you whether you're sure you want to delete the entry. 
Press OK to confirm the deletion; or press Cancel if you decide you do not want to delete the 
contact. 
      
Remember that you can use the telephone keypad to type in part of a contact's name in order to 
find an entry more quickly. Since contacts are organized by first name, type the first few letters of 



a person's first name to jump to his or her entry. For example, you might press "2, 2, 2, 6, 6, 6" to 
create the "CO" that would move you to someone named Constance.      

Custom Contact Groups 
Some users may want to avoid intermingling their personal contacts with business contacts; or 
they may be importing multiple sets of contacts from a PC. If you press your left arrow from the 
address list, you will find yourself in a folder list which, by default, only contains the folder Main. 
This folder may also contain contact lists you have imported; or, to add a second folder into which 
you can organize your contacts, press the Program Menu key and arrow down to "new folder". 
Pressing select will bring up a prompt for the name of your new folder, and pressing OK will save 
it. You should now see the newly created folder listed in alphabetical order along with "Main." You 
may also press the Program Menu button and arrow down to choose "delete a folder". After 
pressing Select, you will be asked to press OK to confirm deletion or Cancel to opt out of 
deletion.     
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The Music Player 
Icon's Music Player lets you organize, manage, and play your audio content. It is not just for 
music! You may read audio books, listen to podcasts, as well as enjoying your favorite music 
even while you work on other activities.  
      
When you select an audio file from another application; for example, an mp3 file in the file 
explorer or a podcast in the RSS reader; the music player will automatically launch with that file 
loaded. To launch the music player directly, press the Applications key from anywhere in the Icon 
system, and then either arrow down until you hear "2: music player", and press select, or press 2 
to open the music player directly.       

Importing Audio Files into the Music Player 
Before using the music player, you need to load audio content onto your Icon. The simplest way 
to do this is to connect your Icon to your PC with the included USB cable and your Icon 
power/sync cable. Once you have connected your Icon to your computer, press 6 and then 3 from 
the Applications menu. This will launch Disk Drive Mode. If your Icon is properly connected to 
your PC, your PC should emit two ascending tones, and your Icon will show up as a removable 
drive from the My Computer screen in Windows. Open this drive and then open the Music folder 
within it. Then, paste any audio content you want to transfer into the Music folder. On average, 
most songs take 5 to 10 seconds to transfer, depending on their file size. Your PC should display 
the name of each song while it is being transferred, as well as an overall estimate of how long 
your file transfers will take. If you have a lot of music you want to transfer, you may start the 
transfer overnight and your transferred files should await you in the morning.  
      
When you're finished transferring content, press the Cancel key on your Icon to exit disk drive 
mode. You are now ready to play your audio content. You may also use the Icon Sync program 
located on Icon's companion CD to synchronize Icon's music folder with the My Music folder on 
your Pc.  For more details, see the appendix on the Icon Sync program.       

Updating the Music Catalog 
The first time you launch the music player, or anytime thereafter when you have added or 
removed audio files, the system will take a few minutes to update the music catalog. When this 
process is complete, the Icon will announce, "music catalog updated". If this process is 
interrupted or needs to be restarted, you should press the Program Menu key from within the 
music player, navigate down to the "rebuild catalog" option and press select.  



      
Disabling automatic update of the music catalog may cause the Icon to perform more 
responsively if your loaded collection of music is very large (5 GB or more). This is because, 
when the option to auto-update is enabled, the Icon checks for updates to your media content 
every time you load the music player. If you wish to disable this option, you must remember to 
manually select the Rebuild Catalog option every time you add music to or remove music from 
the collection in your Music folder.      

Program Menu Options within the Music player 
There are three other options in the program menu that are available in any part of the music 
player. The first, Shuffle, announces whether Shuffle is currently on or off. Pressing select toggles 
this option from "on" to "off" and back again. When Shuffle is off, files will be played in alpha 
numeric order or, if you are playing a playlist, in whatever track order the playlist specifies. When 
Shuffle is on, the files you have chosen to play will be randomized. The Resume item, just below 
Shuffle, allows you to return to the exact track and position where you last stopped listening. This 
option works even if the music player has been closed and then reopened, although it will not 
work if you have updated your software version or allowed your battery to run down completely 
since the last time you listened to music. Underneath the Resume item you'll find Rebuild Music 
Catalog, described above; and finally, below that, you'll be presented with the option of disabling 
automatic updates of the music catalog.       

Accessing your Audio Content 
When you load the music player, you will be placed in a list of ways to choose what audio content 
you would like to manage or play. These music management options are numbered, so that you 
can jump quickly to any of them with just one press of a number key. Option 1, Songs, will bring 
up a list of every audio track available in your Media folder. At the top of this list you will find an 
option to Play All. Press select on this option to start playing your tracks in sequence, and use the 
Program Menu while audio is playing to toggle whether shuffle is on or off. If you want to play just 
one track, you can arrow down past Play All to review all your other songs. A long press of the up 
arrow will take you to the very top of the list, and a long press of the down arrow will take you to 
the very bottom of the list. As with any other list in the Icon, you may input the first few letters of 
the song you're looking for to jump straight to that song. For example, you might press "66, 2, 7" 
to input the "nap" that would jump you directly to a song called Napoleon's Hat. This process is 
not case-sensitive, which means that it will find songs by title regardless of their capitalization. 
      
If you wish to back out of your list of songs and return to the list of music management options, 
press your left arrow key. You may then arrow down and explore the other options. Option 2 is 
Artists. It works the same way as the Songs option, except that there is no Play All option at the 
top of the list. Once you navigate to a particular artist and press Select, you will be presented with 
a list of all the songs you have available by the artist you've selected, with a Play All option at the 
top and the individual songs below it. One press of the left arrow key returns you to the list of 
artists; a second press returns you to the list of music management options. 
      
Option 3 in the list of music management options is Albums, and it groups songs by album name. 
Option 4, which works the same way, is Genre, and finds songs based on the genre specified in 
their file information.       

A Word to the Wise: Organize your Tunes 
When your manual writer loaded her music collection onto the Icon and began to browse by 
genre, she was dismayed to discover that her music collection had been segmented into 
redundant, tiny and unhelpful genre categorizations. There was "Alternativerock" (4 songs), 
"Alternative, rock" (1 song), "Andrew Lloyd Webber" (1 song), and on and on. How could this be? 
      



Although the Icon does a great job of helping you manage your music by title, artist, album or 
genre, it's only as good as the file information with which your music files are tagged. From your 
PC, you may bring up the properties associated with each file. In Windows, the Summary tab of a 
music file's properties will allow you to edit the title, artist, and genre for a song. The most 
common problems with song classification that can be fixed in the Summary tab include 
inconvenient or nonexistent genre classifications; and song titles that actually begin with the 
name of an artist, making songs more tedious to find. Although getting your music collection 
properly labeled is a somewhat time-consuming project, it may pay off the next time you forget 
whether "Walk Like an Egyptian" is by the Bangles or the Buggles; and if you plan to share your 
MP3s, your friends will thank you for taking the time to label them right.      
Creating and Using Playlists  
You may wish to organize your music according to your own preferences. Icon, like many media 
players, allows you to create your own  playlists. To do this, select option 5, Playlists, from the 
music management options in your music player. If you already have playlist files in your media 
folder, these will show up in a list; otherwise, the list will start out empty. To create a new playlist 
to which you can add tracks, simply press the Program Menu key and select option 2, New 
Playlist. You will be prompted to give your playlist a name, which can be just one character or 
several words long. When you're done entering the name press the OK button. Your newly 
created and (for now) empty playlist will now show up in the Playlist list. (As in any list that offers 
file management options, you will find a delete Playlist option in the Program Menu, which you 
can select and then either confirm or abort by pressing cancel or OK.) 
      
Once you've created a new playlist to which you'd like to add audio tracks, left arrow to return to 
the music management options. You can highlight any song, artist, album or genre to add to a 
playlist. For example, to add all your blues songs to a playlist, you can arrow down to Genres (or 
press 4), press select or right arrow to bring up a list of available genres, and then navigate down 
to Blues. The next step will be the same whether you have chosen an individual song, an artist, 
an album or a genre: press the Program Menu button, then navigate to and select the option "Add 
... to playlist", The prompt will be somewhat different depending on what you're adding: you'll hear 
"Add this song to playlist" if you're selecting an individual song, for example, and "Add all songs in 
this genre to this playlist" if you are selecting a genre.  
      
After you have chosen a song, artist, album or genre to add, and selected the "Add to playlist" 
option, you'll be prompted to choose from a list of currently saved playlists to add the selected 
music to. Navigate to the one you want either by using your up and down arrow keys or by 
inputting the first one or two letters of the playlist's name. When you've highlighted the playlist to 
which you want to add music, press either the Select or the OK key. The Icon will respond "OK", 
and your music will be added to the playlist. 
      
When you return to your music management options, either by using the left arrow or by 
reopening the music player at a later time, Playlists will be Option 5. Select the playlist you wish 
to play, and you will be presented with a list of all tracks in the playlist, with a Play All option at the 
top. Remember that you can toggle whether tracks are played in alphanumeric order or 
randomized by selecting Shuffle from the Program Menu.      

Controlling Playback in the Music player 
Pressing Select on an individual song or a Play All option within the music player menus will 
launch the music player, and the music you have chosen will start playing. While music is playing, 
you may press the Select key to pause and resume the audio. A brief press of the left arrow will 
return you to the beginning of the current track; pressing it twice briefly will skip you to the 
previous track. Conversely, a quick press of the right arrow will advance you to the next track in 
the sequence you have chosen. Holding down the left and right arrows causes the Icon to rewind 
or fast forward through your audio selection. 
      



The Icon's keypad offers several other options for navigating through longer audio tracks. You 
can use the 1 and 3 keys to move back and forward by ten second intervals; the 4 and 6 keys to 
move back and forward by one- minute intervals; and the 7 and 9 keys to move back and forward 
by 10-minute intervals. A press of the star key will bring up a multi-line display called What's 
Playing which you can navigate with the up and down arrow keys and which includes the name, 
file path, and duration of the currently playing track. Pressing the Cancel button will return you 
from this dialog to the main music player. 
      
From within the music player itself, four options are available in the Program Menu. The first, 
discussed earlier in this documentation, is the Shuffle option, which toggles between On and Off 
each time you select it. The second option is What's Playing, which brings up the same file 
information as the star key and can be exited with the Cancel button. The third option is Current 
Position which, when selected, informs you of how much time has elapsed in the current track. 
After you hear this information, you are automatically returned to the main music player with no 
further action necessary. The fourth and final option available in the main music player's Program 
Menu is Rebuild Catalog, which starts the process of updating the music available on your hard 
drive without the need to interrupt the music that is currently playing.      

Supported File Types in the Music player 
The current release of the Icon software supports mp3, OGVorbis, and Wav files.     
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The Library Menu 
The Icon provides a host of tools that let you conveniently download, manage and read electronic 
books and periodicals in a range of formats. All of these options are classified under the Library 
Menu, option 3 from the Applications Menu. The three options within the library menu are:  
•         1, bookshelf 
•         2, newsstand  
•         3, Internet book search.  

      
From the applications Menu, pressing 3 for the library menu followed by 1, 2 or 3 for the specific 
library application you'd like to use will bring you directly to the application of your choice.      

Bookshelf 
Selecting Bookshelf from the Library menu will bring up two different ways to browse your book 
collection: you may choose from Authors or All Books. Selecting Authors will bring up a list of 
authors, and you can select a particular author to explore all the books classified under the 
author's name. Selecting All Books will bring up an alphabetized list of all books available on your 
hard drive. From the authors list, you can press the program menu key and get the option to 
delete the author; selecting this option will delete all books by the highlighted author.  From the 
alphabetized list of all books or a list of books by a particular author, pressing the menu key will 
give the option to edit book information (discussed below) or to delete the book.     

Importing Books to Your Bookshelf 
Just as you need to transfer media content before you can use the music player, you should 
transfer some books to the Icon or download some directly (see the section on Internet Book 
Search.) To do this, connect your Icon to your computer with the included USB cable. Then, 
press "6, 3" from the applications menu to enter disk drive mode. Your Icon should show up as a 
removable drive on your PC, and you can open first the removable drive, then the Library folder,  
and finally the Books folder. Paste the books you'd like to read into this folder, and then press 
Cancel on your Icon to exit disk drive mode. It may be most helpful to organize books by author, 



with the books by each author being contained in a folder with the author's name as the title as 
this is how Icon naturally organizes books that are downloaded. 
      
Icon's current software release supports a range of file types including DAISY2, BRF, Microsoft 
Word (.doc), RTF and TXT (text), and HTML. However, only DAISY books come encoded with 
author information, so all books with other file types will be classified under the author "Unknown" 
until you re-label them manually.      

Editing Book Information 
To edit the label information for a particular book, you must first find the book either through 
choosing the author and then highlighting the book, or by navigating to it directly in the All Books 
list. Once you have highlighted the right book, press the Program Menu key. Option 1, Edit Book 
Information, is the first available option, so just press select to choose it. You can now use 
standard editing commands to read and edit the selected book's title. Pressing the down arrow 
key results in the prompt "Authors: press select to change." If you would like to alter author 
information for your book, press Select here. You will be placed in the field containing the book's 
first or only listed author. If there is more than one, the up and down arrows will move among 
them; and you can edit the information in each field. You may also highlight an author, press 
Program Menu, and choose to delete that author. To add another author to the one or more 
already listed, press Program Menu, down arrow to Add Author, and press select. You may then 
enter the name of the author you are adding, and then press OK to save the change.  
      
Press OK from within the book information dialog whenever you're done editing your book's 
information, and you will be returned to the list of titles where you started.      

Opening and Navigating through a Book 
To open a book, simply highlight your choice and press Select. The Icon will respond "opening 
book" and, depending on the file size of the book you're loading, will start reading after between 
one and five seconds. If you are opening a book for the first time, the Icon will start reading from 
the top. Otherwise, you will begin reading wherever you were positioned when you last closed the 
book. You may stop and start continuous reading at any time by pressing the Select key. The up 
and down arrow keys will move you through the book line by line, and the left and right keys will 
move you character by character. To move forward by word, use the right arrow key while the 0 is 
held down; use 0 with the left arrow key to move backward by word. To move to the end of the 
current line, hold down right arrow; to move to the beginning of the current line, hold down the left 
arrow. To move forward by paragraph, use 0 with down arrow; to move upward by paragraph, 
use 0 with the up arrow. To move to the previous page, hold down pound while pressing the up 
arrow: to go to the next page, hold down pound  and press the down arrow. And finally, to move 
to the top of the document, press and hold up arrow; to move to the end of the document, press 
and hold down arrow.       

Navigational Options for DAISY  
DAISY books offer additional options for navigation. Depending on how a DAISY book is 
constructed, the navigation markers may represent print pages, chapters, sections, or a 
combination of all three. To bring up the navigation options available in a DAISY book, press the 
pound key from within the book. You may then arrow up and down through the first layer of 
navigation options. Sometimes there is a second layer: for example, you might find that there are 
navigational markers for every section within a chapter. If a navigational marker contains other 
markers within it, the Icon will tell you how many subsections it contains, and you can press the 
right arrow key to move into the list of those subsections. Pressing the left arrow after you do this 
will return you to the first layer of navigational markers. 
      
Once you have found the navigation marker to which you wish to jump, press the OK or Select 
key and the Icon will position the cursor at the location of the marker you have chosen. If you 



have been browsing through the navigational markers but wish to go on reading where you left off 
before, press Cancel and you will be returned to your previous location.      

Using and Modifying Navigational Markers 
When you press the Program Menu key from within the Bookshelf application, you may arrow 
between two menu choices: Edit and Navigation. The options under the Edit menu include Set 
Selection Mark, Copy Selection, Select All, Find, and Read from Cursor. You may read more 
about these options in the section of the manual dealing with the Edit menu of the word 
processor, since commands in both applications work the same way. 
      
The Bookshelf's Navigation menu includes four options. The first, Document Navigation, brings 
up the same dialog of DAISY navigational markers as you can access by pressing the pound key. 
Selecting the second menu option, Go to Page, will prompt you to enter a page number to which 
you want to navigate. Enter the number on the phone keypad, and then press OK. As long as the 
page you specified is within the range of pages available in the document, you will be jumped 
immediately to the page number you entered. 
      
The third and fourth options in the Navigation menu allow you to jump directly to the beginning or 
end of the currently open book. Remember that if you wish to browse through the menus and 
then return to your book without selecting a menu choice, you can press Cancel and you will be 
returned to the position where you stopped reading.  
      
When you wish to close the book you have open, simply press Cancel and you will be returned to 
the Applications Menu. Remember that pressing the Applications Menu instead of pressing 
Cancel will allow you to open another application while still keeping the Bookshelf open in the 
background. You can navigate back to the Bookshelf at any time, while it is running, by holding 
down the Applications key to bring up the task manager. 
      
A primary difference between the Bookshelf and word processor is that you cannot edit books in 
the Bookshelf. Any attempt to press alphanumeric keys will result in the prompt "Document is 
read only". However, you may still copy passages from a book into the word processor to be 
edited or added to a document you are working on. You'll find details in how to copy and paste 
text in the section of the manual dealing with the word processor.      

The Icon with Bookshare 
The second and third options in the Icon's Library menu, Newsstand and Internet Book Search, 
require a subscription to Bookshare.org to work. Bookshare is an online repository of books and 
periodicals that had over 30,000 books and 80 newspapers and magazines at the beginning of 
2007. Memberships can be purchased by any person with a print-reading disability, or can be 
earned through "sweat equity": in other words, by volunteering to help build the website's book 
collection. Visit the website, www.bookshare.org, for information about how to become a 
member.       

Newsstand 

Subscribing to Newsstand Periodicals 
The second option in Icon's Library menu is the newsstand. From the applications menu, it can 
be accessed by pressing 3 and then 2. When you open the Newsstand for the first time, you will 
hear the announcement "Periodicals: empty list" because the Icon does not come preloaded with 
any periodicals. After ensuring that your internet connection is on -- either through the USB cable 
connected to your PC, the wireless radio, or the Icon's docking station -- you may press the 
Program Menu key and select option 6, Add a Periodical.  
      



If you have not elected to save your Bookshare information previously, you will be prompted for 
your Bookshare.org user name, which is the E-mail address you used to sign up. Enter it using 
the keypad, and then arrow down once to enter your password. (Remember: capital letters come 
after digits in the rotation when you enter alphanumeric characters on the keypad. The @ (at) 
symbol is second in the punctuation sequence offered by the 1 key, and the . (dot) is the first.) 
Arrow down once more and you will be prompted to decide whether you'd like to save your 
password. A saved password stays active until the Icon is reflashed. If you are the sole user of 
your Icon, you will probably want to save your password to avoid the need to type it in the future. 
Press the Select key to toggle between "yes" and "no" in response to this prompt. If you have 
previously performed an Internet Book Search, you may have already saved this information, and 
Icon will simply say “Logging in to Bookshare.org.” 
      
When you have entered your user name, password, and preference in regard to saving the 
password, press the OK key and your Icon will attempt to log you in to Bookshare. If your user 
information is invalid or your internet connection is not functioning, you will receive a message 
that the log-in has failed and you will be returned to the user name and password prompts. 
Otherwise, you will be placed at the beginning of a list of all the periodicals Bookshare has to 
offer. 
      
Move through the list with the up and down arrow keys, or type the first couple of letters of the 
periodical to which you would like to subscribe. The list is alphabetized with the exception of the 
economist which appears at the bottom of the list, and can be quickly reached with a sustained 
press of the down arrow. When you come to a periodical that interests you, press the select key. 
You will be prompted to specify how long you would like the Icon to keep old issues of the 
periodical you have chosen. Simply press the OK key if you want old issues kept until you 
manually delete them; enter the number of days you would like to keep issues if you would like 
them eventually to be erased, and then press OK. Down arrow once more to choose whether you 
would like to subscribe to the periodical you have selected. By default this item is set to yes, but 
you may set it to no if you do not want the periodical in question automatically downloaded, but 
want to access it at will. 
      
Once you have chosen the settings you want for the periodical you've selected, press OK. The 
Icon should announce "periodical added" and return you to the list of periodicals. From here, you 
can choose to subscribe to as many additional periodicals as you wish. To leave the subscription 
screen when you're done, press the Cancel key.      

Downloading Your Periodical Subscriptions 
When you are ready to download the periodicals you've subscribed to, press the Program Menu 
key from the main screen of the Newsstand and select option 1, Get All New Issues. If your 
Internet connection is working the Icon will download all the newspapers to which you have 
subscriptions and will announce when it has finished with an ascending set of clicks. During the 
download, you will hear a swishing sound every few seconds to let you know that the download is 
progressing. You may press status twice in quick succession to hear information about how many 
issues have been downloaded and how many are left. Remember, if you have added a periodical, 
but have chosen not to subscribe to it, it will not be included in the Get All New Issues operation.  
  
If you would like to update a particular periodical rather than downloading new issues of all your 
subscribed periodicals, arrow to the periodical you would like to update and select option 2 from 
the program menu, Get New Issues For This Periodical. If you would like to modify the settings 
you selected when you added a periodical, highlight the desired periodical and choose the third 
option in the program menu, Periodical Settings. If you no longer want the periodical on your Icon, 
highlight it in the list of periodicals and delete it using the 4th option in the program menu. If you 
want to delete a particular issue of a periodical, arrow to the desired periodical and use the right 
arrow to get to the list of issues. Highlight the particular issue you wish to delete and choose 
option 3 under the program menu, Delete Issue.       



Opening a Periodical 
From your list of subscribed periodicals, right arrow to open the list of all issues for the one you 
have highlighted. Right arrowing again, or pressing select, will open the specific issue you have 
highlighted. 
      
Bookshare periodicals come in the DAISY format, which means that navigation within them is 
similar to navigation using the Bookshelf. There is one notable difference: when you open a 
periodical in the Newsstand, you will start out in the first layer of navigational markers. Generally, 
these markers refer to main sections of the paper, e.g. National, Foreign and Editorial. You may 
use the up and down arrows to navigate among these main sections, and the Icon will announce 
how many subsections are contained in each one. Right arrow once to bring up the list of articles 
within a particular section, and press Select at any time to jump to the relevant part of the 
periodical. 
      
Once you have opened an article, you may press Cancel to return to the navigation screen. You 
may read continuously for as long as you like across articles and sections, but when you press 
Cancel you will still be in the navigational position from which you opened the first article you 
chose.      

Using and Modifying Navigational Markers in Newsstand 
The Newsstand offers exactly the same Edit menu as the Bookshelf. For details on copying and 
pasting text, and performing a find, see the information about the Edit menu in the manual's 
section on the Word Processor.  
      
The Newsstand's Navigation menu is also equivalent to the one available in the Bookshelf. You 
may use it at any time to bring up the open periodical's navigational markers; to jump to a page; 
or to go to the very beginning or very end of the periodical. The Newsstand's Program Menu also 
offers the Subscribe to a Periodical and Check for New Issues options from within a periodical.      

Internet Book Search 
The third option within the Library menu is the Internet Book Search, which interfaces with 
bookshare.org to allow you to quickly and easily download books for offline reading. You may 
select it from the Library menu, or press 3, 3 from the Applications menu.       

Searching by Title or Author 
When the Internet Book Search opens, you will be presented with a menu of three choices. The 
first two, Search for Author and Search for Title, operate in the same way: press select on one of 
these two options, and you will be prompted to enter a title or author to search for (It is acceptable 
to enter partial titles and authors). When you have finished entering your search query, press the 
OK key and the Icon will respond, "Searching". After a few seconds, you will be presented with a 
list of titles or authors that match your search. (If nothing matched your search, the list will be 
empty.) Navigate using the arrow keys to the title or author that interests you. 
      
To download a highlighted title, simply press Select on the title you would like to download, and 
the downloading process will commence. If you have not elected to save your login information 
for Bookshare, you will be prompted to enter this before your first selection begins downloading. If 
you have saved your information, Icon will announce “Logging in to Bookshare.org: and will then 
begin downloading the book. The Icon will let you know when it has finished downloading by 
saying "done". You may then select another book in the list to download, press left arrow to return 
to the search menu, or press cancel to exit the internet book search program. Pressing Select on 
an author will bring up a list of all titles by that author, and you may then select one or more to be 
downloaded.      



Accessing Additional Book Information 
Sometimes, you may want more information, such as the copyright date, number of pages, or 
synopsis of a book, before you decide whether to download it. If you would like to review this 
information, highlight the title that interests you, press the Program Menu key, and choose option 
1, Book Information. You may arrow down through fields describing the book, including synopsis; 
title; date added to the Bookshare collection; the quality of the electronic book (ranging from 
excellent to fair); the number of pages; the ISBN; copyright date; and the name of the copyright 
holder. Some of these fields may be blank. When you are finished reviewing a book's information, 
press the Cancel key to return to the list of your search results.      

Searching by Category 
When you choose the third menu option within the Internet Book Search, Browse Categories, the 
Icon will retrieve a list of the categories of books available on Bookshare: for example, there are 
categories for Art and Architecture, Teens, and Cooking, Food and Wine. Press Select on any of 
these categories to bring up a list of the books contained in that category. Press select on any 
book to download it, or press left arrow to return to the previous menu.     
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The Internet Menu 
You can use your Icon while connected to the Internet to browse the web, check your E-mail, 
keep up to date with your favorite RSS feeds, and download podcasts. There are four possible 
ways to connect to the Internet: 
        
•         Use the included wireless radio to connect to your home wireless network or a "hot spot" 

(an open network at a business such as a restaurant or hotel 
•         Connect the Icon with the included USB cable to your PC, and the Icon can use your PC's 

Internet connection. 
•         Use the Ethernet connector on the docking station for a wired, high-speed connection 
•         Use the phone modem on the docking station to access a dial-up connection.      

A Few Words on Getting Connected 
You may use your home Internet connection with the Icon, either through your home wireless 
network or USB connection or, with the optional docking station, with the Ethernet or dial-up 
modem. It is often possible, however, to find free wireless networks away from home. Your 
friends or office may have a wireless network; or you may find free, open networks at commercial 
locations such as coffee shops, hotel lobbies and airport waiting areas. In densely populated 
urban areas, it is increasingly common to find at least one wireless network almost wherever you 
go.      

The Wireless Control Panel 
Since the wireless radio included in the Icon system drains the battery life of the unit about twice 
as quickly as normal, the wireless radio is turned off by default. There are two ways to turn it on. 
You may either hold down Program Key 2, at the extreme upper right corner of the keypad, for 
about two seconds; or you may select Wireless Control Panel from the Internet menu. Either 
action will activate the wireless radio and cause the Wireless Control Panel to appear. 
      
Once you turn on the wireless radio and start the Wireless Control Panel, Icon shows a list of all 
the wireless connections in range. You may attempt to connect to any of the listed networks by 
highlighting it and then pressing select. Each item in the list contains the network SSID (or name), 
whether the network is open or secure, and the signal strength of the network. Ideally, you should 



try to connect to a network with a listed signal strength of a higher number: you'll probably get a 
more stable connection from a network listed at -40DB than one listed at -80DB; remember the 
higher a negative number, the smaller its absolute value. Once you press select on a non-secure 
network, a connection attempt will be made right away. If the network to which you want to 
connect is listed as secure, this means that it requires a security key. If you press select on a 
secure network, you will be prompted to enter the security key, and you should then press the OK 
key to proceed with the connection. When the Icon announces "connected to" followed by the 
name of the network you have chosen, you'll know you have a working Internet connection. The 
message "Connection attempt failed" will be spoken if the wireless signal for the network you're 
connecting to is too weak or if you enter an invalid security key for a secure network. 
      
Your Icon will remember the connection settings for networks you have connected to 
successfully. You may delete these in the Network Manager, discussed later in the manual, but 
by default your Icon will automatically connect to any network to which you have connected to 
previously.  Remember, turning your wireless radio off when you are not engaged in tasks that 
require an Internet connection will maximize your battery life. You may toggle the wireless radio 
on and off with Program Key 2, or turn it on and off through the program menu in the Wireless 
Control Panel; or you may end the Wireless Control Panel process, if necessary, from the Task 
Manager. 

Setting Up a USB Network Connection through Your PC  
When your Icon is connected to your PC with the USB cable, you may use your PC's internet 
connection from the Icon. To do so, select the USB connection from the Network Manager option 
of the Internet menu. 
      
Set up USB Networking before using the internet through the USB connection for the first time, 
you must create a network profile on Icon and install the USB network drivers and bridge your 
internet connection to Icon's network connection. 
      

Install Network Drivers   
Installing the network drivers is a two step process. You first install the handler, then once the 
Icon tries to connect to the PC, the handler finishes the network driver installation. 
      
1. Insert the program CD into your Windows XP or Vista machine.  2. Select USB Network 
Drivers from the menu. The network driver installation wizard starts.  3. Use the wizard to 
complete the installation.  4. Connect your PC to the Icon with the USB cable.  5. Open Icon's 
Network Manager from the Internet Menu. Icon responds, "Network Connections Menu."  6. Press 
the menu key to show the options available from the Network Manager.  7. Select Add 
Connection from the program menu. Icon responds with a list of connection types.  8. Select USB 
from the Connection Types menu. Icon responds with another menu where you name and 
configure the connection.  9. Type a name for the new connection.  10. Press OK to accept the 
name of the new connection. Icon creates the profile for the new connection and returns to the 
Connections menu.  11. Select your new connection from the list. Icon responds, "Connecting," 
and Windows responds with the New Hardware wizard.  12. Complete the steps in the New 
Hardware Wizard. When the New Hardware Wizard completes, your Windows machine has a 
new network connection named Levelstar LAN Link."  13. Select Network Connections from the 
Control Panel on your PC.  14. Highlight the connection named Levelstar LAN Link and press 
Space to select it.  15. Use Ctrl+Up or Ctrl+Down to find and highlight your internet connection.  
16. Press the Application key on your PC. Windows responds with a context menu.  17. Select 
Bridge Connection from the context menu to bridge the Icon's network connection with your 
internet connection. 



The Network Manager 
The fourth item in the Internet Menu is the Network Manager. The Network Manager allows you 
to set up and manage connection profiles for the various types of networks Icon supports. You 
can open the Network Manager by selecting it from the Internet Menu, or by typing 4, 4 from the 
Applications Menu. Each time you connect to a wireless network successfully, Icon automatically 
creates a profile in the Network Manager. However, if you are using another connection type, i.e., 
USB, Ethernet, or dial-up, you’ll need to set it up manually through the Add Connection option in 
the Network Manager’s program menu.  
  
When Network Manager opens, you are presented with a numbered list of the profiles currently 
saved in your Icon. You can move among them using the up and down arrows. As you arrow up 
and down the list, Icon will say the name of the profile and whether or not the Icon is connected to 
it. If you have not yet connected to a wireless network or set up a profile manually, Icon will 
announce “Network Connections Menu, empty”.  
  
As has already been described, Icon will automatically connect to saved wireless network profiles 
when wireless is turned on through the Wireless Control Panel or by pressing and holding 
Program Key 2. You may also connect to a profile, wireless or otherwise, by highlighting it in the 
Network Connections list, and selecting option 2 from the Program Menu, Connect to Profile. Icon 
will say “Connecting to profile, please wait.” When connection has been successful, you are 
placed back in the Network Connections list, and now when you arrow past the network to which 
you are connected, Icon will announce the status as connected and will give details about the 
connection such as connection type, IP address, subnet mask, etc. 
  

Adding a Connection 
While it is preferable to create a profile for a wireless network using the Wireless Control Panel, 
you will need to, for all of the other network types, at least specify whether or not to use DHCP, or 
rather, whether Icon should obtain an IP address automatically or use a static IP address. This 
will depend on the configuration of the network to which you are connecting, and this information 
can be obtained through your network administrator. To specify this information, you will need to 
create a profile through the Network Manager’s menu. To create a new profile, press the Program 
Menu key from within the Network Manager and choose the first option, Add Connection. You are 
then presented with another menu which lists the network types available: these are 1, Ethernet; 
2, wireless; 3, dial-up; and 4, USB. Press select on your desired connection type. You are then 
presented with a list of fields specific to your connection type. The first field for all types asks for a 
name for your profile. When you have entered a name, arrow down to the next field which is, in all 
profile types, “Use DHCP?”. Use the select key to toggle between yes and no. If you are setting 
up a USB or an Ethernet network profile, these are the only 2 fields presented, so, if you choose 
yes to DHCP, in which case you want Icon to obtain an IP address automatically, after filling 
these in, you may press OK to save the profile. However, if your network requires you to use a 
static IP address, you’ll want to say no to the DHCP option, and will need to fill out the fields that 
will then appear below it. These are Static IP Address, Net Mask, Default Gateway, DNS Search 
Path, Primary DNS, and Secondary DNS. All of these items consist of groups of numbers 
separated by periods and should be available through your network administrator should your 
network require them. 

Wireless Profiles 
When adding or editing a profile for a wireless network, there are several more fields specific to 
wireless connectivity. The SSID field requests the name given to the router. The next field in the 
list asks for the channel on which the router is operating. Arrow down once more, and you’ll find 
the Security field. You can move among the options using the left and right arrows. If the network 
is open, the security option should be set to none. Icon supports 64 and 128 bit WEP encryption. 
If your wireless network uses WEP, you will arrow down to a final field in which you are asked for 



the security key. When you have entered all of the relevant information, press OK to save the 
profile. 

Setting up a Dial-up Profile 
In addition to the Profile Name and DHCP fields, the dial-up profile contains several other items. 
Below the DHCP field you will find Phone Number, Username, and Password, in to each of which 
you must type the relevant information. The final field asks for the type of authentication used, 
and gives a list of choices you may navigate using the left and right arrows. As with all profiles, 
once all of the information has been filled in or selected, press the OK key to save the profile. 
  
In addition to the options previously described, the Network Manager’s program menu contains 2 
other options: option 3, Edit Profile; and option 4, Delete Profile. The Edit Profile option will open 
a field list according to the network type that matches exactly what you would see if you were 
creating a profile. If you choose to delete a profile, you will be asked to confirm whether you 
would like to perform this action. Press OK to say yes, and cancel if you change your mind and 
wish not to delete the profile.  
  
As with most other Icon programs, all of the menu options with the exception of Add Connection, 
act on the highlighted item in the Network Connections list. As you navigate through the menu 
options, both the action and the profile to be acted upon are announced. For example, if you 
navigate to the Delete Profile option while a network called Linksys is highlighted, Icon will 
announce “Delete Profile, Linksys”. 
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Browsing the Web 
Icon's state-of-the-art web browser lets you browse the World Wide Web, interact with forms, and 
listen to media streams.  The developers have combined the power of Fire Fox, a mainstream 
application, with custom speech prompts to create a browser unparalleled among mobile devices.  
      
You may reach the Web Browser by selecting it from the Internet menu, or you may press 4, 1 
from the Applications menu. When the Web Browser launches, the first page it displays is 
Google's web search.  To open a different webpage, press the Program Menu key. Select option 
7, File, and then option 1, Go to URL, or type Control + O from anywhere in the browser. You 
may then type in the web address you wish to visit and press OK. The Icon will announce 
"loading", and begin reading the webpage you have chosen as soon as enough information is 
loaded for reading to begin. The Icon will inform you that loading is still in progress by making a 
swishing sound. When loading is complete, you will hear a series of ascending clicks. You may 
stop and start continuous reading at any time with the Select key, just as you can in Icon's other 
text-based applications. 
      
You may use the Icon's standard navigation commands to move through a webpage (left and 
right arrows to move by character, up and down arrows to move by line, 0 with left and right 
arrows to move by word, 0 with up and down arrows to move by paragraph, and all other 
commands for document navigation.) The Icon will identify any links, edit fields and graphics as 
they occur on the page through the use of various voices and sounds. (See the section in the 
manual on Browser Settings for details on how to change the individual voices that announce 
browser elements.)  A blip will indicate that you are navigating across a link.  To activate a link 
when your cursor is positioned on one, press the OK key.  
      
When the Icon encounters an input control on a webpage, it will let you know by announcing the 
type of control, such as a button or edit box, and switching to whatever voice you have selected in 
the Browser Settings for reading forms.  In an edit field, simply enter alphanumeric characters as 



you would in any text-based application.  If the Icon announces that you are dealing with a multi-
line edit box, you may use the OK key to insert new lines.  If you are on a radio button or check 
box, use the Select key to toggle between the yes/no or on/off options.  If you are in a list box, 
you should use the left and right arrow keys to navigate among list items, and exit the list choice 
with your up or down arrow key.   
      
In addition to standard navigation keys, there are some special shortcuts that will enable you to 
move through webpages with ease. The 1 and 3 keys navigate backward and forward by 
heading. The 4 and 6 keys move backward and forward by link. The 7 and 9 keys move 
backward and forward by edit fields and other form controls.   To return to the top of a page at 
any time, press the 2 key.  To skip past links and graphics to the next chunk of plain text, press 
the 0 key.  This shortcut comes in handy when you're reading something like a movie review or 
newspaper article and want to skip past a pack of tedious links to other parts of the page.  Keep 
in mind that, if you are in continuous reading mode, reading will not stop when you use these 
navigation keys.  Your position will be changed every time you press one, and the Icon will 
continue reading down the page from that point.  This is great if you're trying to quickly browse a 
page, but if you want to start moving in a controlled fashion from item to item, you should press 
Select to stop continuous reading before attempting to move through the page.   
      
You can use the 5 key to initiate a search of the page you're viewing.  Type in your search string, 
arrow down to toggle case sensitivity on and off, and press OK.  Every time you use the 5 key, a 
find will begin at the top of the page.  If you'd like to continue to the next Occurrence of the same 
search term, use the 8 key instead, and you’ll be jumped directly to the next found instance of 
your search string. 
      
A cautionary note: When you have navigated onto an input control, you should arrow past it 
before pressing 9 to go to the next form, since the Icon attempts to input text when you press 
alphanumeric keys while inside an input control.          

Web Browser's Program Menu 
In the Web Browser's Program Menu, you'll find all the other options you need to manage web 
content.         

Adding Bookmarks 
Option 1 from the Program Menu allows you to bookmark a page so that you can quickly navigate 
to it later. Pressing Select on this option presents you with a form, beginning with the title of the 
page you are bookmarking. If you wish, you can edit this title, or you may leave it unaltered. 
Arrow down and you will hear the address of the page you are bookmarking. Editing this field is 
not recommended, since this is the part of the bookmark that points to the exact location of your 
page, but if you are familiar with the structure of the website you are visiting you may change the 
target address. When you're done editing your bookmark, press the OK key, and the bookmark 
will be added to the bookmark list.    

Bookmarks 
Selecting option 2 from the Program Menu, Bookmarks, brings up a list of pages you have 
previously bookmarked. Move through the list with the up and down arrow keys, or type in the first 
few letters of the bookmarked title of the page you would like to visit. Press the OK key to 
navigate to the highlighted bookmarked page. 
            

Managing Multiple Web Pages 
Navigate to option 3 in the Program Menu to manage tabs.  By using Tabs, you can have more 
than one webpage open at a time.  For example, you might like to keep an audio site like 
Shoutcast in the background while you check your E-mail, or you might want to bounce between 



Amazon and Powell's Books to do some comparison shopping.  The first time you open Tabs, 
option 1 will be New Tab, and option 2 will be the webpage you already have open.  Selecting 
option 1 will launch a blank page, with the accompaniment of a horn sound.  When you hear "new 
page", you'll know you're in the blank page.  If you try to read it at this point, the Icon will instruct 
you to "Open a URL in this tab."  You may do this by choosing Program Menu item 7, File, and 
then item 1, Go to URL or pressing Control + O, just as you would in your first tab.  Once you 
have multiple tabs open, you will see them all listed under the Tabs item, and may switch to any 
one of them by pressing Select.  When you have multiple tabs open, option 2, Close Tab, will 
bring up a list of all currently open tabs when you select it.  Navigate to the tab you'd like to close, 
press select, and you will hear "Tab closed" when the action is completed.  This will allow you to 
close the tab of your choice without exiting the web browser as a whole. 
      
It's a good idea to monitor how many tabs you have open, and take notice if you have several 
open at once and the system seems to lag or slow down.  Generally speaking, it's not a very 
good idea to keep more than three tabs open, and you should drop that number to two if you 
have another memory-intensive application, like streaming media, open at the same time.      

Web Tools 
Option 4 in the browser's Program Menu is called Tools and can be reached from anywhere in 
the browser using the shortcut Alt + T. The first option in this menu is called Google Web Search.  
When you select this item, you will be prompted to enter a search string, which will be sent 
directly to the Google search application.  Enter your search terms and press OK, and you will be 
directed to a webpage of Google search results.  Your cursor will automatically be placed on the 
first search result, but from here you can navigate just as you would in any web page.   
      
Tips for using Google: With or without the Icon's special search feature, many Google services 
work very well with speech access.  To get the most out of Google searches and other services, 
we recommend downloading Google Hacks, by OReilly Publishers, from Bookshare.  This book is 
divided into easy-to-understand chapters which you may navigate to through preset navigation 
markers if you read it in the Icon's Bookshelf.  This book is updated periodically and older 
versions remain on Bookshare, so make sure to check all the title results and get the most up-to-
date edition. 
      
Icon users may also benefit from bookmarking the following page: 
labs.google.com/accessible 
      
This page combines regular Google search functionality with some special heuristics that attempt 
to rank pages based on their accessibility.  For example, if you search for "books" the Barnes and 
Noble website makes it into the top ten search results, but Amazon does not.  The heuristics 
aren't perfect, but they may help steer you toward accessible content that works well with the 
Icon. 
  
Mouse Over Support 
  
The next three items in the tools Menu have to do with internet pop-up menus. Often times on a 
webpage such as levelstar.com, you’ll navigate to an item with a screen reader and hear the 
words “on mouse over” spoken. This means that one can hover their mouse over this item, and a 
menu of clickable options will pop up. For instance, if you hover your mouse over the Products 
item on the Levelstar webpage, you’ll get a menu with the clickable items Icon, Docking Station, 
and accessories. To get that menu to pop up in Icon’s browser, you would navigate to the 
Products item and press and hold the select key or choose option 2 in the tools Menu. To left 
click an option in the pop-up menu, press and hold okay or choose option 3 in the Tools Menu. To 
right click an item, choose option 4 in the tools Menu. 
  
Links and Headers Only 



Options 5 and 7 in the Tools Menu let you choose to view a webpage in 2 alternative formats.  
Option 5, Links Only Mode, can be activated by pressing Control + L from anywhere in the 
browser, and will display only the links on a webpage; leaving out all text, form fields, headers, 
etc. Option 7, Headers Only Mode, can be activated with Control _ H, and will display only the 
headers. You can exit either of these modes by pressing the shortcut key a second time, or going 
back to the item in the Tools Menu which will then read Exit Links or Headers Only Mode.     

Focused Link and URL 
Last Focused Link and URL is the fifth option in the Program Menu.  When you select this option, 
the Icon will read whichever link on the page currently has focus, and then read its URL, or web 
address.  Pressing Status and then Help will spell the URL.      

Download Manager 
The Download Manager is the 6th option in the Program menu.  You'll only need to visit it if you 
have a download in progress.  When you navigate to downloadable content, such as a word 
document or an MP3 file, you should press select, and you'll be given the choice to (1) open or 
(2) save the download.  If you choose option 2, the file will be downloaded in the background and 
you can keep surfing the web.  Go to the Download Manager to check on the progress of your 
downloads.  A list will appear. It will be empty if no downloads are in progress.  Otherwise, use 
your up and down arrow keys to navigate through the currently downloading items, and press 
Select to update the progress reports in the list.  From the Program Menu at this point, you may 
choose option 1 to cancel the highlighted download.          

File Menu 
Option 7 in the main Program menu of the web Browser is called File, and contains two 
options.         

Go to URL 
Option 1 is Go to URL.  Select this option, type in the web address you'd like to visit, and press 
OK to launch that webpage.         

Settings 
Option 2 within the File submenu is Settings.  Select it and a dialog will appear.  This dialog 
contains settings specific to the web browser.  The first setting is "Play link sound?" and refers to 
the blip that you hear, by default, when you navigate across a link.  The Select key toggles this 
option from Yes to No.  Arrow down, and you may choose, again with the Select key, whether you 
want to hear the Icon announce the word "graphic" before it reads graphic text.  The third option 
as you arrow down is "Start reading after a find operation", and is set, by default, to no.  Press 
Select to toggle this option to Yes if you want the Icon to commence continuous reading after a 
find operation.  Arrow down again to choose whether the Icon should remind you to use your left 
and right arrows to navigate through lists.  You may want to toggle this option off once you're 
used to remembering what to do in a list box.  Arrow down once more to choose whether you 
want continuous reading to stop when you use the up or down arrow keys.  By default this option 
is set to No, so your up and down arrow keys will not stop continuous speech and will essentially 
let you rewind and fast forward through your current document.  As you continue to navigate 
down the settings dialog, you'll come to Start Page.  By default, Google launches when your web 
browser starts, but you may change this to any page you like by entering the page's address on 
this prompt.  When you're done, press the down arrow key again.   
      
The next option in the Settings dialog sets the minimum length of text chunks.  Remember, you 
can use the 0 key to navigate to a text chunk of whatever length you set.  This will help you 
navigate past links to the main content of any page.  Enter a number of Characters here.  It can 



be smaller or larger than 50, but very small numbers may catch titles and other small text bits, 
and very large numbers may cause you to skip text chunks you might like to read. 
      
Moving on down, you can toggle, with the select key, whether the Icon starts continuous reading 
when a new page loads.  The default is set to no. 
      
The final four options in the dialog let you control, in order, the browser text voice, link voice, 
graphic voice and form voice.  Treat these items just as you would the other voice items in the 
main Speech Settings dialog in the Utilities Menu.  To summarize, the 1 and 3 keys lower and 
raise pitch; the 4 and 6 keys control speed; and the 7 and 9 keys cycle through available voices. 
      
When you're done customizing your browser settings, press OK to save them.  If you think you 
might have made changes you don't want to keep, press Cancel to exit the settings dialog without 
changing anything.    

Edit 
Option 8 on the browser's Program menu is the Edit Menu and contains items similar to those 
found in the Bookshelf, Word Processor, and other text environments.  All of these items contain 
shortcut keys that can be activated anywhere in the browser. The options are Copy Selection, 
Control + C; Set selection Mark, Alt + M; Clear Selection Mark, Control + M; and Find, Control + 
F. Use the selection options to copy a section of a webpage to an e-mail or document in the Word 
Processor. Select Find to launch a Find dialog where you may enter a search string and, by 
arrowing down, determine whether your search will be case-sensitive.  Press OK to proceed with 
the find operation, or Cancel to abort it.        

Navigation 
The 9th and final option in the browser's program Menu is the Navigation submenu.  It contains 
five options.  The first, Stop Loading, allows you to abort the loading of a page that is taking too 
long to access.  Sometimes, reloading can clear up a problem with accessing a page.  Option 2, 
Backward, will let you navigate to the previous page in your browser history.  Option 3, Forward, 
will allow you to navigate forward to access the next page in your history once you've gone 
backward.  Option 4, Reload, will load a new instance of the page you're on.  This can be useful if 
you're accessing a page, like a Facebook news feed or a stock ticker, which frequently updates 
with new information.  Finally, use option 5 to get the title and URL of the page you're currently 
viewing.  Once you've selected this option, tap Status and then Help to have the URL spelled 
out.  Arrow down to hear the title of the page: again, use Status followed by Help to spell it.  Press 
OK when you're done. 
      
Tips for streaming audio:  The Icon lets you stream or download audio files that have an MP3, 
M3U, or PLS file extension.  Streaming means that the audio is being played on the server you're 
accessing: internet radio is generally something you stream, and you can often stream files that 
have been saved on the website you're visiting.  Downloading will save the audio content to your 
Icon.   
      
The Icon works like a dream with Shoutcast, a popular website for finding Internet radio.  When 
you've searched for a station or selected a genre to display from one of the lists on the page, 
every result will have a graphic above it that says TuneIn.  Press OK on this graphic to choose 
whether to open or download the stream.  If you choose Open, the audio player will launch, 
playing your chosen stream.  Remember: this is Internet radio, so fast forward and rewind will not 
work while you're playing it.  They will, in fact, send you straight out of the audio player and back 
to your webpage.   
  
You may choose to save a stream instead of opening it.  You will be saving the location of the 
stream, not the music itself.  You will be prompted to choose a drive and directory, just as you 
would in a text-based application.  Make sure not to change the file extension while you're 



saving.  The default filename you're given will always be "ShoutcastPlaylist.pls", regardless of the 
title of the station, so it's best to erase everything but the ".pls" at the end and write in a name that 
will make sense to you when you access it later.  We recommend setting up a folder called 
Streams for all of your favorite radio stations.  Once you've saved your streams, you may find and 
launch them from within the file explorer, even if the web browser isn't open.     
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Email 
Your Icon's Email application, combined with the increasing availability of free wireless internet 
access, and free POP3 e-mail accounts such as gmail and yahoo, gives you access to email 
virtually anywhere. Icon's email application works with any POP3 enabled internet service, and it 
provides functionality to read and organize your mail and to create and send messages.         

Navigating the Folder List 
When you enter the Email application, Icon will place you in the Inbox; this is one of the standard 
folders in the email application's Folder List. To access other folders, first arrow left to move out 
of the Inbox. The Icon will announce that you are now in the Folder List. >From here, you can 
arrow up and down to navigate the list as you would in any other Icon menu. Arrowing right will 
place you in the selected folder and, if the folder contains messages, at the top of that folder's 
Message List. The other built-in folders in the Email application are Outbox - for outgoing 
messages waiting to be sent, Sent Mail - for outgoing messages that have already been sent out, 
and Trash - for messages that have been marked for deletion. You will learn how to customize 
your Folder List in the Additional Features section.        

Setting up Email 
When you first open the Email Application, the Icon will place you in the Inbox, and announce 
Inbox - Empty Folder. In order to be greeted with the thrilling announcement of a non-empty 
folder, you will need to set up the Icon to access one of your existing email accounts! If you do 
not have an email account, you can sign up for a free one at any number of popular sites, and 
with the Icon's web browser, you don't even need to go to a computer to do so.  
      
In order to set up the Icon to retrieve messages from your POP3 email account, you will need to 
have the following information: your email address, your password, the POP3 incoming mail 
server for your email provider, and the POP3 outgoing mail server for your provider. You can 
usually find this information on your mail server's help or FAQ pages by searching them for POP. 
Once you have this information ready, enter the program menu and navigate to or select option 
11, Accounts. Option 1 in the Accounts menu is New Account. Once you have your accounts set 
up, they will be listed below this option in the menu and selecting an account name will place you 
in the account management menu where you can edit or remove the selected account. For now, 
though, select New Account. The Icon will ask you for each of the pieces of account information 
mentioned above. Once you have entered it, confirm the account information by pressing the 
Select/OK button.        

Message Navigation 
To download new mail messages after setting up your account, press the Program Menu key and 
select the first option Send/Receive. The Icon will say “connecting to…” the name of your 
account, and you will hear a swishing sound every few seconds to let you know that the process 
is progressing. You may use the Program Specific Status command as in the Newsstand to 
check the progress. If you have 30 messages to download and Icon is currently downloading 
message 14, pressing Status twice quickly will yield “Receiving message 14 of 30”. When 
downloading is complete, you will hear a series of ascending clicks.  



  
New messages downloaded from your email service will be added to the Message List in your 
Inbox. While in the message list, the Icon will read off the header information of the currently 
selected message. Header information includes such details as the subject, sender, and date and 
time of message. Pressing the Select key will open the current message to be read; pressing the 
asterisk key will delete the message. 
      
When you open a message, you can read and navigate it as you can any other document on 
Icon. The Icon will begin reading the body of the message automatically. Pressing the Select key 
will stop the reading and allow you to navigate through the text. Arrowing up and down will move 
through the message by line; arrowing left and right by character. Pressing select again will 
restart continuous reading. While reading or writing a message, the Email program menu will 
contain an additional Edit sub-menu along with the standard Email options. This gives you access 
to the select, copy and search actions. 
      
Press Cancel to close the message and return to the message list. 
  
Press asterisk to delete the message and open the next one and begin reading. 
      

Attachments 
When a message contains one or more attachments, this option appears in the menu and 
provides a list of the message's attachments. Navigating to and then selecting an attachment will 
open yet another menu with the options to open or save it. If you choose to save the attachment, 
you will be prompted for the drive, directory, and desired file name. If you choose to open it, Icon 
will launch the application associated with the file type and load the file.    
  
You can reply to a message using the Reply option in the program menu, which brings us to the 
Email Management section and a detailed look at the Email Application's program menu.     

Email Management & Menu Options 
Like the program menus of other Icon applications, the Email program menu varies slightly by 
context, as we have already seen with the addition of the Edit submenu when reading a 
message. Other options depend not on context for display but on the ability of the action to be 
performed; for instance, the New Message feature is available from anywhere, but it will not 
appear as an option until you have set up an email account.         

Send and Receive  
When you have set up your email accounts, this option checks your email provider's server and 
downloads new messages. It also sends out any mail messages you've placed in the Outbox.     

Empty Trash 
When you delete a message from a folder, it is not immediately deleted but moved to the Trash 
folder, accessible from the Folder List. To permanently delete these messages you use this 
option, Empty Trash.    

New Message 
The New Message option will first step you through the header information, asking you to fill in 
the To: and CC: recipients, the subject line, and to select any attachments you'd like to send with 
the message. Once you confirm these pieces of information by pressing the OK key, it opens a 
composition environment where you can write the body of your message. 
      



You can go back and modify your header information by going back to the menu and selecting 
the Headers option.    

Reply 
When a message is open or selected, the Reply option in the menu will take you to the same 
composition environment provided when creating a new mail message with one exception. 
Because the Icon can determine the necessary header information from that of the message you 
are responding to, it skips over the headers form and takes you directly to the composition 
section. You can still modify any of these headers by selecting the Headers option in the 
menu.       

Headers 
Choosing the Headers option in the menu, will provide you with access to change the From, To, 
Cc, and Attachment information on the active message. The From field will provide a selection list 
of the email accounts you have set up in the Email application which you may navigate by first 
pressing select, and then moving through the list using the up and down arrows. Press OK when 
you have made your selection, and continue through the fields using the up and down arrows, 
typing the relevant text. Note that if you are using Braille entry that computer Braille is required in 
all of the header fields containing e-mail addresses.      

Move Message to Outbox 
When you have finished creating a new or reply message, you will need to press Cancel to reach 
the message menu. Here you are presented with 2 options: 1, move message to the Outbox; and 
2, discard message. The Outbox folder, stores it so it can be sent the next time you select Send 
and Receive. If, after thinking on it, you do not want to send the message, choose option 2 and 
the message will be discarded.       

New Folder 
This option allows you to create your own folders for storing messages.       
  

Edit 
As mentioned above, the Edit menu becomes available when reading or creating a message. It 
provides you with the common Edit options: select, copy, search, etc. When creating a message, 
you also have spellchecking available as is available in the word processor.      

Navigation 
The navigation option does not pertain to the general Email environment; it provides options for 
navigating the current email message. You can return to the beginning or skip to the end, or if the 
message supports them, go to specific sections or pages.           

Filters 
The filters option provides a sub-menu of tools to help organize your messages. You can create 
filters to move messages satisfying certain criteria, such as sender or subject, to a specific folder, 
or you can make use of built in filters to find more messages related to the message currently 
open, as with the first filter option, Filter Messages From this Sender, which uses the address 
currently in the From field and finds all other messages from that person. You can also modify 
this address before using the rule. Another built-in rule is Create Filter from Mailing List which 
looks for messages going to the same group of people as the current one, then moves the 
messages it finds to a folder of your choice. This filter pertains to outgoing messages and is 
available only when the messages are being sent to one of your pre-defined mailing lists.       



Creating a Custom Filter Rule 
You can create your own rules for managing messages using the next option down in the Filters 
sub-menu: New Filter. This enters you into a form where you first specify what criteria to match in 
which header fields. Filter On is the field you wish to search in. Filter Text is the content you want 
to search for, for instance if Filter On were set to From, this would be the sender's email address. 
Filter Action selects the action to perform on messages matching the criteria. Currently Icon only 
supports the Move to Folder action. Selecting this will provide you with a selection list of 
folders.           

Preferences 
The Preferences menu option allows you to modify which headers are listed in your message list 
and by which headers messages get sorted.          

Accounts 
You've already encountered the basic features of this option when you set up your first email 
account. In addition to the top most menu item, New Account, the Accounts option will list any 
email accounts you have already set up. Selecting any existing account will present you with two 
options: edit account or remove account. When you edit an account you will be able to modify any 
of the fields you originally set up as well as some advanced configuration options. The fields are: 
      
Account Name - the label you assign to differentiate the account from your others, for instance 
personal vs. work. 
          
Account is Default - this sets whether or not this account is automatically set as the sender when 
creating new messages 
      
Real Name - the name you want displayed with the email address to recipients of your emails  
      
Email Address - the actual email address for your account  
      
Incoming Mail Server and Incoming Mail Server Type - the server address and server type for 
your email service provider. Some servers require that you additionally supply the port number for 
the server. You would do this by adding a colon and then the port number after the domain 
address, for instance the incoming server for gmail is pop.gmail.com and uses port 995; so this is 
entered as pop.gmail.com:995.  
      
Leave Messages on Server - this sets whether or not new messages are removed from the 
server when you download them to your Icon. If you have a computer at home or work where you 
also want to have access to the messages, make sure this is set to no. 
      
Incoming Username and Password - these are the username and password you use to log into 
your account 
      
Outgoing Server and Outgoing Server Type - Like the incoming server information, you need to 
get this from your service provider. Also it too may require a port number after the address using 
the same form, colon then port number. For example, the outgoing server for gmail would be 
entered as smtp.gmail.com:587. For server type, Icon supports Simple Mail Transport Protocol 
(SMTP) and SMTP with Transport Layer Security (TLS) extension to prevent eavesdropping on 
your email sessions. Gmail accounts require the SMTP with TLS option. 
   
Outgoing Server Authentication - some services, such as gmail, and Yahoo use secure POP3 
which means they require authentication in order to send mail so that spammers are not able to 
highjack your e-mail address. When you set this to Yes, Icon uses the same username and 
password to send your mail as it does to retrieve it from your email service.     
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RSS Reader 
The acronym RSS stands for Really Simple Syndication. The Icon's RSS reader interfaces with 
any website that has an RSS feed to automatically download new content from the website. In 
this way, you can keep up with a variety of online periodicals and blogs without having to visit 
their websites every time you wonder if they've been updated. Since any new content is saved to 
your Icon, you can browse much of the news (and content from websites offering RSS feeds) 
while you're offline. This means more productivity on the road and less of a drain on the battery, 
since you can review RSS content while the wireless radio is off. 
      
You may enter the RSS Reader application either by selecting it from the Internet menu or by 
pressing 43 from the Applications menu. When the application loads, you will hear the word 
"Feeds". Icon's developers have preset the RSS reader with a variety of interesting feeds; so 
although you will almost certainly want to add your own, you may want to start by exploring the 
presets. Press the right arrow key to enter the list of feed categories. By default there are four: 
news, podcasts, Fun Stuff, and Icon and Braille Plus User Site; and you can use the up and down 
arrow keys to navigate among them. Pressing the right arrow on any of the choices will bring up a 
list of the preset feeds, with the exception of News which is divided in to several subcategories. 
Here, you’ll need to choose one and right arrow once more before you will reach the list of feeds.  
      
To update a feed (that is, to download the new content from the listed website), highlight the feed 
you're interested in, press the Program Menu key, and select option 5, Update Feed. You'll 
receive the message "Updating feed" and, within a minute or so, all the updates to the feed will 
be downloaded. Alternatively, you may press option 2, Update All Feeds, from the Program 
Menu, to update all of your RSS feeds in one action. However, it should be noted since this 
option downloads every feed to which you are subscribed, it may take a long time. You may also 
choose to update all the feeds in a particular folder. To do this, highlight the desired folder, and 
choose option 5 in the Program Menu, Update Folder. While feeds are downloading, you may 
review the ones that have already downloaded, or you may work in another application. You may 
press the status key twice in rapid succession from within the RSS application to check the 
progress of the updating and caching process. Also, as you arrow past each feed, you will hear 
its status: "updating feed" if the download is still in progress, the number of new articles 
downloaded if it is finished, or an error message if the download was not successful. 
      
You may select Stop Feed Download from the Program Menu at any time to halt the download 
process. When the update is complete, you will hear a series of ascending clicks like those in the 
e-mail program to let you know the process is complete.  
      
To review the information contained within a feed, just highlight it and press the right arrow key. 
Then, you may use your up and down arrow keys to navigate through the list of articles, or 
sections of the website, that have been downloaded. To open one and start reading, press select, 
and then use your standard reading keys to read the article. To return to the list of articles, press 
the Cancel key.      

Managing Feeds 
To add a new RSS feed, position yourself in the folder list and highlight the folder where you'd 
like to include it: for example, the Slate.com feed would belong in News, General. Choose option 
6 from the Program Menu to reach the Folders menu, and, in that menu, option 1, Add Feed,, and 
you will be prompted to enter either the exact URL of the feed to which you want to subscribe, or 
the URL of the website where the feed is located. 
      



If you know the exact URL of your feed, simply enter it and press OK. If not, enter the name of the 
website; for example, slate.com; and press OK. The Icon will present you with a list of feeds 
offered by the website you entered, and you may use your up and down arrow keys to browse 
them, and the Select key to choose one. The Icon will say "feed added" when you have 
successfully subscribed to a feed.  
      
You may edit the name and URL of a feed by highlighting it and selecting the Feeds Menu, option 
6 from the Program Menu, then selecting Edit Feed. Arrow down to move from the feed's name to 
it's URL, use your standard editing commands, and press OK when you're done. You may also 
choose to delete a feed by selecting Delete Feed, option 2 from the Feeds Menu when the feed 
targeted for deletion is highlighted. Finally, option 3 in the Feeds Menu allows you to move a feed 
to a different location. 
      
When you are in the RSS application's folder list, you can perform several actions pertaining to 
folder management using the folders menu. Option 2 allows you to add a new folder. Remember 
that a folder can be created from the Feeds line when the RSS application is first opened, in 
which case it will appear at the same level as Fun Stuff, News, etc. You may also create a folder 
within a folder in order to create a subcategory such as is present under the News category. 
Adding your own folders will help you stay organized if you plan to subscribe to a large number of 
feeds. You might want to create your own folders to keep track of friends' blogs or financial news, 
for example.       
  
Choose option 3 in the Folders Menu to edit the name of the highlighted folder. Choose option 4 
to delete the highlighted folder; and option 5 to move the highlighted folder to a different location. 
Options 6 and 7 in the Folders Menu allow you to import feeds in to RSS folders, from other RSS 
applications such as Juice and to export feeds from Icon to other RSS applications or pod 
catchers. To import feeds from another application to Icon, place the Icon in Disk Drive Mode and 
connect it to your PC. Open the pod catcher on your PC and choose the Export option from 
among its menus. Choose to export the OPML file to the removable drive under which your Icon 
is listed. After exiting Disk Drive Mode, open Icon’s RSS application and choose the Import to 
Folder option. Navigate to where you have saved the OPML file on your hard drive and select it. 
  
To export feeds from Icon’s RSS program to a pod catcher on your computer, reverse the 
process. Choose the Export option in the folders menu, and choose a place to store the OPML 
file on your hard drive. Connect your Icon to your computer and place it in Disk Drive Mode. Open 
your pod catcher and choose Import from among its menus. Find the file on the removable drive 
under which the Icon is listed and select it. 
  

Downloading Podcasts 
A podcast is an audio or video file attached to an RSS feed. To download a podcast, update the 
feed that contains it, and then right arrow into the list of downloaded articles. If a podcast is 
attached to one, you will hear either "Marked for download" or "Not marked for download" after 
the name of the article. Use the select key to toggle marking on or off. Then, select option 4, 
Download Podcasts, from the Program Menu, and the podcasts you have marked will be 
downloaded. 
      
While podcasts are being downloaded, highlighting them will speak, in addition to the title of the 
article to which they are attached, the percentage of the download that has been completed. 
When a podcast finishes downloading, you may press the Select key to begin listening to it. The 
Music player will launch with the podcast loaded, and you can use your standard music player 
commands to navigate through it.      



RSS Settings 
From the RSS application, option 8 in the Program Menu allows you to set your preferences for 
how the Icon handles feeds. The first prompt on the settings screen asks you to decide, with the 
left and right arrow, whether you would like articles downloaded for offline reading. If you select 
No, you'll save space on the hard drive, but you won't be able to browse articles when you aren't 
connected to the Internet. 
      
The next option asks the maximum number of articles you'd like to store in each feed. By default, 
this number is 50, but you can enter a higher or lower number. When your maximum is reached, 
older articles will be automatically deleted. 
      
Next, you'll be asked the number of days you'd like to keep articles. By default, the number is ten 
days, but you may raise or lower it. 
      
The next option reads, "Mark new podcast for download automatically?" By default, this option is 
set to yes, but you may press the right arrow key to change it to No. If you have a slow Internet 
connection or limited space on your hard drive, you may want to select No, since podcasts are 
audio files and are much larger in size than a typical text-based RSS feed. 
      
The next option prompts you to enter the maximum number of new podcasts you'd like 
automatically marked for download. The default number is 3.  When you're done customizing 
your settings, press the OK key and you will be returned to the place where you entered the 
settings screen.     
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The Tools Menu 
Option 5 from the Applications Menu, Tools, contains a suite of powerful applications that will 
allow you to manage documents, recordings, appointments and notes with ease. The applications 
within this menu are:  
•         1, word processor 
•         2, planner 
•         3, voice recorder 
•         4, calculator 
•         5, stopwatch 
•         6, journal       

Word Processor 
Icon's word processor allows you to write, read, and format documents in a range of formats 
including text (.txt), rich text (.rtf), ascii Braille (.brf), Microsoft Word (.doc), and .ldf, Levelstar's 
own mobile document format. You may access the word processor from the Tools menu, or by 
pressing 5, 1 from the Applications menu. When you launch the word processor, a blank 
document will open. You may use the alphanumeric keys, thumb Braille, or an external keyboard 
to compose text. When using the telephone keypad, to delete the character to the left of the 
cursor, use the star key. To input a space, press the 0 key. 
      
Use your left and right arrow keys to move backward and forward by character; use them with the 
0 key held down to move by word. Use the up and down arrow keys to move by line; use them 
with the 0 key held down to move by paragraph. Hold down the left and right arrow to move to the 
beginning and the end of the current line respectively. Press and hold the down arrow to reach 
the bottom of the document; press and hold the up arrow to get to the top of the document. Hold 



down the Pound key with the up and down arrows to move by page. You may also press the 
select key to start and stop continuous reading from the point where your cursor is positioned. 
      
The word processor's Program Menu contains three submenus: File, Edit and Navigation which 
may be accessed using the Menu key and the number pad, or using shortcut keys. Alt+f will get 
you to the File menu, alt+e the Edit menu, and alt+n will open the Navigation menu.       

File Management 
The first option within the File menu is Save File and can be accessed by pressing control+s. 
When you select this option, if the file has not been previously saved, the Icon will prompt you to 
select a target directory; that is, where you want your file to go. Use your up and down arrows to 
choose between the hard drive and the internal flash disk, then press the right arrow key to enter 
the list of available folders. Arrow up or down to the folder where you would like to save your file, 
and then press Select. You will be prompted to enter a file name. When you have finished, press 
the OK key, and you will be prompted to select a file format. Move among the available file 
formats with your left and right arrow keys, and then press OK to confirm your choice. At this 
point, your file will be saved, and you will hear the announcement "saving .. file saved", followed 
by the full path and name of the file you have saved. If you have previously saved the file, you will 
simply hear the Icon say "saving" and then "file saved" and the file path. Note: Icon remembers 
the location in which you last saved a word processor file, and will present you with that as the 
default location next time you save a file. 
      
The second option in the File menu, Save As, works exactly the same way as the Save option, 
except that it allows you to create a new version of a file that you have already saved without 
altering the original version. 
      
The third option in the File menu is New Document, and can be accessed from anywhere in the 
word processor by pressing control+n. It will create a new, untitled document, and you'll be able 
to keep other documents open in the background. Option 4 in the File Menu is Open Document, 
and can be accessed with control+o. You will be prompted to choose a drive, folder, and finally a 
file to open. Highlight the desired file and press OK. Select option 5 from the File Menu, Close 
document, or press alt+f4, to close your active document and end the word processing session 
unless you have another document open. Before closing a document, you will be prompted to 
decide whether to save any changes you have made since the last time you saved it.  
          
If you have more than one document open during a word processing session, you will see option 
6, Switch to Open, within the file menu. Pressing Select on this option will present you with a list 
of currently open documents. Highlight one of them and press Select again to bring that 
document into focus.       

Editing 

Editing: Cut, Copy, Paste 
The Edit menu, a submenu of the Program Menu, will allow you to manage the text you have 
written. To mark a block of text to copy, cut or delete, move your cursor to the beginning of the 
block. Then press the Program Menu key, choose Edit, and then select Set Mark, or press alt+m 
at the location where you would like the mark set. This marks the beginning of the block of text 
you want to manage. Move to the end of the text you wish to manage, and then return to the Edit 
menu. If you have correctly set a mark, you can perform the following actions: Cut Selection (to 
move your selection to the clipboard), Copy Selection (to copy your selection to the clipboard 
without altering its place in the current document) and Delete Selection (to completely remove the 
selection you have marked). If you decide you no longer want the mark placed where you have 
set it, you can also clear the selection by choosing option 6 from the Edit Menu or by pressing 
Control + M.   



      
You may also choose Select All from the Edit menu and then perform a cut, copy or delete to take 
action on the entire text of the document. 
      
If you have cut or copied a selection to the clipboard, the option Paste Selection will appear in the 
Edit menu. Select this option to paste the contents of the clipboard to the current location of your 
cursor. You may also use shortcut keys from within a document to perform these actions. Use 
control+x to cut selection, control+c to copy a selection, control+v to paste a selection, and 
control+a to select all. 
      
You may format the text you have selected by choosing option 8 from the Edit menu, Paragraph 
properties.   This option brings up a dialog of choices about how your text is presented. The first 
item in the dialog refers to text alignment (centered or left- or right-justified), and you may 
navigate among the available options with the left and right arrow keys. Arrow down to choose 
between single, 1.5-line, or double spacing: again, use your left and right arrows to navigate 
among the choices. When you have finished, press the OK key to return to your document.     

Editing: Find and Replace 
You may choose option 9, Find, from the Edit menu or press control+f to search for a specific 
string of text. Input the string you'd like to search for, then arrow down to choose whether to 
search from the cursor. Use the Select key to toggle between Yes and No. If you choose Yes, 
your search will begin at the location of your cursor. Choosing No will start the search at the top 
of the document. Arrow down once more, and use the select key to toggle whether the search is 
case-sensitive; in other words, whether it will restrict the search to letters with the exact same 
capitalization that you entered. When you are finished setting your search preferences, press OK, 
and the cursor will be moved to the first occurrence of your search string. To search for the next 
occurrence, return to the Edit menu and select option 10, Find Next or press control+shift+f.  
Option 11 in the Edit menu, Replace, works the same way as the Find option, except that 
beneath the search string prompt there is a second prompt which asks for the text with which 
you'd like to replace the search string. As you continue to arrow down through the find dialog, 
you'll find first a Replace All option for replacing every occurrence of a search string, and then a 
Replace Next option for replacing only the first occurrence. Press Select on either option to 
activate it, and the text you have input will be substituted with the replacement string you 
entered.     

Editing: Spell Checker 
Options 12 and 13 in the Edit menu, Check Spelling from Cursor and Check Spelling, offer a 
quick and efficient way to proofread your documents. choose option 12 to check only the portion 
of the document below your cursor; choose option 13 to check the entire document. When you 
press Select, the spell checker will start by announcing the first error it finds.  
      
Once the Icon has found an error, the first option in the Spell Checker dialog is Suggestions. The 
Icon will first announce the problem word and then propose a suggestion. If the first suggestion is 
not the correct one, use your left and right arrows to navigate through the list of other 
suggestions. If none of the suggestions are appropriate, you will continue down to the Edit Here 
line of the dialog to correct your error manually. 
      
Arrow down past the list of suggestions and, if you've selected a suggestion that fits, press either 
option 2, Change, to change only one occurrence of the problem word; or select option 3, Change 
Remaining, to change all remaining occurrences in the document. Options 4 and 5, Ignore Once 
and Ignore Remaining, allow you to skip past a word once or throughout the document. Option 6, 
Add, will add the problem word to the dictionary, consider it correct from now on, and continue 
with the spelling check. Option 7, Edit Document here, will exit the spell checker and return you to 
the document with your cursor positioned on the problem word. You may resume the spelling 



checker after manually correcting the problem word the spelling checker has found by re-entering 
the Edit menu and selecting Check Spelling again.       

Navigation Menu 
The Icon's word processor contains the same options under the Navigation menu as are available 
in the Newsstand and Book Reader. You may choose from option 1, Document Navigation; 
option 2, Go to Page; option 3, Go to Start of document; and option 4, Go to End of Document. 
However, option 1, Document Navigation, will only bring up navigational information for types of 
documents like HTML, which have navigational information embedded.       

Planner 
The Icon's planner allows you to organize your schedule by creating appointments with or without 
alarms and browsing your created appointments by day, week, month or year. A convenient line 
in the Information and Status Center will inform you any time you have an appointment on the 
current day. You can even attach a file to an appointment: for example, you might attach the 
agenda of a meeting you're scheduled to attend, or a syllabus for the first day of class, so that 
you can retrieve it effortlessly when your appointment occurs.  
      
You may open the planner either from the Tools menu, or by pressing 5, 2 from the Applications 
menu. You may also open the planner by pressing Select on the line within the Information and 
Status Center that displays your appointments for the current day. Either way, the Planner opens 
on the current day, and announces whether or not you have appointments scheduled for this 
day.      

Finding Appointments 
The Icon planner lets you check whether you have appointments by day, week, month or year. 
When the Planner first opens, you may press the left and right arrow keys to move backward and 
forward by days. Pressing the up arrow key will switch you to moving with the left and right arrow 
keys by week, month or year. Browse across days, weeks, months or years until you hear the 
number of appointments within the period of time that interests you. Use your down arrow key to 
narrow down your search: the Icon will always announce whether there are appointments 
contained within a given unit of time as you arrow past it. Finally, when you come to a day where 
appointments have been scheduled, down arrow to view By Appointments, and use your left and 
right arrow keys to explore the appointments you have scheduled.      

Creating Appointments 
Creating a new appointment is easy. Press the Program Menu key and select option 1, Add an 
Appointment. You will be prompted for a description of your appointment. Write a few words here 
to describe the appointment to yourself, and then press down arrow. You will now be asked to 
enter the date of your appointment in MMDDYYYY format: that is, two digits for the month 
followed by two for the date and four for the year. For example, if you wanted to remind yourself 
of a friend's birthday on July 12, 2007, you would enter 07122007. When you're done entering the 
date, down arrow again and you will be prompted to enter two digits for the hour and two digits for 
the minute when your appointment will occur.  
      
Arrow down once more to choose, using the select key to toggle between the choices, whether or 
not your status during the appointment is busy. If you select Yes, the Icon will not allow you to 
schedule other appointments that overlap with the one you're scheduling. This will help you avoid 
overbooking your time with conflicting tasks. You should choose No for events like holidays and 
anniversaries that do not conflict with meetings and other obligations. 
      
Now, arrow down to enter, in minutes, the length of your appointment. The default setting here is 
30 minutes. Setting a specific length for all-day events is unnecessary, but you should schedule 
specific obligations accurately so that the Icon will be able to help you detect and avoid conflicts. 



      
Down arrow again and you'll be prompted to decide whether you want an alarm for this 
appointment. By default, the Icon does not create an alarm, but you can press Select to change 
that. At this point the Icon will ask you to choose from a list including 1 for None; 2 for Custom 
alarm; 3 for the same time as the actual appointment; 4 for 5 minutes; 5 for ten minutes; 6 for 15 
minutes, and so on. Use the Custom Alarm choice if none of the listed options reflects the 
warning time you need the alarm to give you before your appointment, and you can enter any 
amount of time, in minutes, and press OK. If one of the preset alarm times works for you, just 
highlight it and press select.      

Setting up Recurring Appointments 
Back on the main appointment creation screen, down arrow again to specify whether your 
appointment repeats. By default, an appointment occurs only once, but you can press Select to 
change this and you will be presented with a list that includes the options None (no recurrence), 
daily, weekly, monthly or yearly. Press Select on the option you want. If you choose daily or 
weekly, you will be prompted to specify the number of days to skip between each occurrence. For 
example, if you want to schedule time for yourself to exercise every other day, you would respond 
to the prompt by pressing 1, and the appointment would be set to occur every second day. 
      
The Yearly option in the recurrence menu works a little differently. Option 1 is called Every. 
Selecting this option will prompt you to choose first the month, and then the day, when your 
yearly appointment happens. This is a good way to schedule birthdays and other events that 
always have the same date. Option 2, On The, guides you through a process where you schedule 
an appointment by the relative day it happens. First, you select from a list containing First, 
Second, Third, Fourth and Last. Then, you specify which day of the week your appointment 
should be scheduled for. Finally, you select the month into which your appointment falls. For 
example, to schedule the Super Bowl, you might choose the first Sunday in February. The Icon 
automatically determines what date that is, and reminds you accordingly. 
      
The Monthly option in the recurrence dialog lets you specify how many months to skip between 
occurrences, and it also allows you to choose between option 1, Numeric Day or Option 2, Non-
numeric attribute. If you choose Numeric Day, you'll be prompted to enter the day of the month 
when your appointment occurs. If you select Non-numeric Attribute, you'll be prompted to choose 
whether your appointment is the first, second, third, fourth or last position for that day of the week 
during the month; and then to select the day of the week itself. For example, you might have a 
meeting on the third Wednesday of every month. Notice that, in addition to the named days of the 
week, this dialog lets you specify Day to indicate how many days into the month the appointment 
occurs, without regard to day of the week; or to tether the appointment to a particular weekday or 
weekend day. For example, you might remind yourself to pay the cable bill on the 5th day of 
every month; or to have a meeting with your staff on the first weekday of every month. 
      
When you're done setting all your appointment parameters, press OK and your appointment will 
be created.      

Editing and Deleting Appointments 
To edit the details of an appointment you have already scheduled, highlight it and select Edit 
Appointment from the Program Menu. You will be presented with the same dialog as you use to 
create a new appointment, and you can alter any of the information it contains. When you're 
done, press OK to confirm the changes you've made; if you don't want to make those changes, 
press Cancel. 
      
To delete an appointment, highlight it and select Delete Appointment from the Program menu. 
You will be prompted to press either OK or Cancel to choose whether you're sure you want to 
delete the appointment. If you're deleting an appointment that recurs, the Icon will then ask you to 



clarify what you want to delete. You may choose to delete the highlighted occurrence only; all 
occurrences in the future; or all occurrences, future and past. 
      
You may jump directly to any date in the Planner to determine whether you have any appointment 
schedule on that day by selecting option 2, Jump to Date, from the Program Menu, and then 
entering two digits for the month, two for the day and four for the year you'd like to jump to.      

The Alarm 
If you've set an alarm, it will beep whether the Icon is on or off. The Icon will read the description 
of your appointment as well as sounding the alarm. To dismiss an alarm while it is beeping, press 
the OK key.      

Voice Recorder 
The Icon offers a high-quality tool for recording audio content.  Although it is called the Voice 
Recorder, you may set it up to work well with recording music or other types of stereo sound.  
The Voice Recorder works with the Icon's built-in microphone, or with an external microphone of 
your choice plugged into the audio input jack on the left side of the unit's upper edge. 
      
To access the Voice Recorder, navigate to the Tools menu and select option 3, or arrow down 
until you hear the Voice Recorder option and press Select.  The unit will respond "Finding 
Recordings", even if this is your first time opening the recorder application.  After a short pause, 
you will find yourself positioned in a list of the recordings on your hard drive.  The unit will say "no 
recordings" if this list is empty.  Pressing the right arrow key will move you into a list of recordings 
on your internal flash disk; and, if you have inserted a Mini-SD card, pressing right arrow once 
more will bring you into the list of recordings on the card.  Arrowing up and down through any of 
these lists will move you through any existing recordings in the list; and pressing select on any 
one will launch it in the audio player, where you may use the same navigation strategies as you 
would in the Music Player.        

Managing Your Recordings  
In the Program Menu, you will find additional tools for managing your recordings.  You may select 
Option 1, Rename a Recording to change a recording's name, or Option 2, Delete Recording to 
discard a recording you no longer need. You may also use the * key when a recording is 
highlighted to delete it.  In either case, you will be prompted to decide if you're sure you want to 
delete the recording.      

Settings for Controlling Quality, Source, Environment, and File 
Naming 
Option 3 within the Program Menu is Recording Settings.  When selected, this option launches a 
dialog that allows you to control the quality and other parameters of your recordings.  The first 
item with which you are presented is Recording Quality.  Use your left and right arrow keys to 
cycle through the choices, which range from "Voice, Low Quality" to "Music, highest quality."  All 
the settings denoted by "voice" are mono, which means that they record on one channel; the 
"music" settings are stereo, meaning that they will create a recording that has two channels for 
left and right-oriented sound.  As quality increases, so does the disk space required to host a 
recording; and stereo recordings, since they record two channels at once, are more space-
intensive than mono recordings.  A low- or medium-quality voice setting will be fine for quick 
notes: for example, you might use it to record your grocery list.  If you're recording an important 
lecture or a piece of music, though, consider using a higher recording quality. 
      
Arrow down once to choose between using your internal microphone to create a recording and 
using an external microphone plugged into your audio input jack.  External microphones are sold 



in a range of qualities and for a variety of specialized uses: look to the Internet or an electronics 
store for guidance on what kind to buy for your purposes. 
      
Arrow down once more to the next option in the dialog, which controls recording level.  Use your 
left and right arrow keys to select a level between 0 and 63.  The louder the environmental sound 
you are recording, the lower the recording level needs to be.   
      
It is a good idea to test the recording settings you have chosen by recording a short audio clip 
before you commit to using them for an important task.  You can easily return to the settings 
dialog to fine-tune the settings after you test them, and  in addition, you may change the 
recording level on the fly as you record.   
  
The final option in the Recording Settings Dialog is the Recording Name Template. This lets you 
customize how your recordings are named by Icon. If you arrow down to this option, then use the 
left and right arrows to navigate the line by character, you’ll discover several letters flanked on the 
left side by % (percent) signs. Each letter denotes a component of the file name, and may be 
deleted or moved in order to customize how Icon names your recordings.  
  
By default, the Icon’s Recording Name Template contains the following: %d, 2 digit day of the 
month; %b, Abbreviated month name; %H, 2 digit hour as denoted using a 24-hour clock; %M, 2 
digit minute; and %S, the second denoted in 2 digits. Removing any of these %-letter 
combinations will delete that component from the title given to the recorded file. Changing the 
order of the combinations will change the order of the components in the file’s title. In addition to 
the components in Icon’s default template, you may choose from a host of other %-letter 
combinations to customize your titles using other components. Some of these are, %a, 
abbreviated weekday name: %A, full weekday name; %B, full month name; %I, 2 digit hour using 
a 12-hour clock; %m, month written in 2 digits; %p, a.m. or p.m.; %y, the year in 2 digits (2007 as 
07); and %Y, the year in 4 digits.  
  
You may also type words in the Recording Name Template. When you do this, the word will 
become part of the file’s title along with the other components. This may be useful in a situation 
where you want a group of recordings to be easily distinguished from the rest of the recordings in 
your list. If you record class lectures, you could change words in your Recording Name Template 
for each class, so when you went back through your list of past lectures, all of the lectures from 
your English class might have English in the title, your psychology class could have psychology in 
the title, etc. This also might be helpful if you attend a conference. You could have all the 
recordings you make at that conference contain the word “conference” as well as the time and 
date in their file names.  
  
Note: All components of a file name, whether words or %-letter combinations must be separated 
by a space. You may delete any item in the template by right arrowing past it, and pressing the 
star key to backspace over it. To insert an item, use the left and right arrows to navigate to where 
you want the item inserted and type the word or component symbol.  When you are done 
customizing your settings, press the OK key to save them.        

Making a New Recording 
To create a recording, navigate to the list of existing recordings that reflects the desired 
placement of your new recording -- to place a recording in the hard drive, highlight the 
"recordings on hard drive" list.  When you have customized the recording settings to your 
satisfaction, press the OK key and, after a short pause, the Icon will announce "Begin 
Recording."  While you're recording, you can use the up and down arrow keys to raise and lower 
the recording level to suit changing circumstances in your audio environment.  If you raise the 
recording level too much, you may begin to receive a clipped signal, causing distortion in your 
recording.  If this happens, the Icon will vibrate to let you know, and you should lower the 
recording level until the vibration stops.   



      
You may pause and resume recording at any time by pressing the Select key.  This feature can 
be particularly helpful as a study tool for recording verbal notes, recording steps in a route, or 
creating other sequential records within a single recording. When you have finished recording, 
press the Cancel key and you will hear Icon say "saving" and you will be placed in the recordings 
list with the recording you just made highlighted.      

Recording while Multi-tasking 
You may continue to record while in another application.  Pressing the Application Menu key will 
not disrupt your recording, and you can use the Applications Menu or the Task Manager to return 
to the recording dialog at any time to pause or stop your recording, or to adjust its audio level.  
When you're done with your recording, press the Cancel key, and your recording will be displayed 
in the list, named by the time and date it was created.  You may change this name to anything 
you like with the Rename option in the Program Menu.        

Hearing Voices?    
When you use the Icon without headphones, the built-in speech will emanate from the internal 
speakers, as always, and will be picked up by the internal microphone.  This is ideal if you're 
composing an Icon tutorial: for almost any other purpose, it is not desirable at all.  To keep the 
Icon from providing an accidental soundtrack to your recordings, you should either (a) press 
Select to pause recording before changing the audio level or performing other functions; or (b) 
simply plug in your headphones, which will keep your speech output neatly separated from your 
audio input.      

The Calculator 
The Icon's built in calculator works by using the numbers of your keypad, the star, select, and 
cancel keys and the four arrow keys.       

Basic Operations 
Digits in the calculator are entered by using the alpha-numeric keypad you are already familiar 
with; however, where in text editing modes you access the decimal point or period via the One 
key, and numbers after several repeated presses of an alphanumeric key, here, the pound key to 
the right of the 0 digit enters a decimal point, and the keypad is always in Numbers Mode. Use 
the star key to backspace if you make a mistake. The four basic functions are performed by the 
arrow keys. Arrow Up for Multiplication, Down for Division, Right for Addition, and Left for 
Subtraction. To get an exponent, press the up arrow twice in rapid succession. To get the result 
of the expression, press the Select key; it functions as Equals while in the calculator. Pressing the 
Cancel button will clear whatever is currently being stored by the calculator, whether it is part of 
an expression not yet completed or the results returned after pressing Select. Pressing Cancel 
when no value is active (for instance, after you have already cleared the results of the last 
expression or before you have entered one) will return the Icon to the Applications Menu.       

Equations with More Than One Operation 
There are two ways to perform multi-operation equations. You can enter all steps prior to hitting 
Equals, or you can total your results as you go. When you press one of the arrow keys after 
totaling the results of an expression, the calculator uses the results as the first value in the next 
expression. So, for example, if you were at a restaurant and wanted to get a subtotal of your 
order then add a tip or tax and get a new total you could do this by hitting equals after adding up 
all the items. The Icon would then announce the sub-total. You would add the tip by hitting Right 
Arrow, entering the value of the tip, and then pressing Select again. The Icon will announce the 
new total.       



Advanced Calculator Functions  
In addition to the simple calculations already outlined, Icon's calculator can be used to perform 
more advanced functions using the eval function from the Python programming language.       

Stopwatch 
You can find the Stopwatch in the Tools menu: press 5 to select it, or arrow down to it and press 
Select.  Icon simply says "Stopwatch stopped" when the application opens.  To start the 
stopwatch, press select: to pause it, press Select again.  Press OK to hear how much time has 
elapsed and whether the stopwatch is stopped, paused, or running, and press Cancel to clear the 
stopwatch.  Remember: pressing Cancel, in addition to clearing the stopwatch, stops it; so if you 
want to start timing a new event, you must press Select.        

Journal 
Icon's Journal allows you to keep daily records and to synchronize with popular journaling hosts 
on the Web, such as LiveJournal.  You may access it by pressing 6 in the Tools menu, or by 
arrowing down to it within the Tools menu and pressing Select. When the Journal launches, the 
Icon will say "journal calendar", followed by today's date, followed by the number of entries 
already inserted for this day.  You may navigate through the journal calendar in the same way 
that you move through the planner: in brief, use your up and down arrows to select whether you 
are moving by entry, day, week, month or year; and use your left and right arrow keys to move 
one at a time among those units.  (For more details on calendar navigation, see the Planner 
section of this manual.)  When you have highlighted an entry you'd like to read, press Select.  
You may then arrow down through the elements (subject, date, time, content) of the entry, and 
press Cancel to return to the calendar.  When an entry is highlighted, selecting option 2 from the 
Program Menu will delete it.        

Creating a New Entry 
To create a new journal entry, highlight the day under which you'd like to classify the entry, press 
the Program Menu button, and select option 1, Add Entry.  You will be prompted to enter a 
subject for your Journal entry.  You may leave this line blank if you wish.  arrow down to confirm 
that the date selected is the one you want.  If it isn't, enter two digits for the day, two for the 
month, and four for the year in this space.  Arrow down once more to confirm the time of your 
journal entry. Arrow down again to the "Content" prompt, and press Select to start writing your 
journal entry.  You will find yourself in a window essentially similar to a word processor document, 
and your usual editing and navigation options are available to you.   When you're finished 
composing your journal entry, press the Cancel key and your entry will be saved to memory. 
      
From this point, arrow down again to select the privacy level of your journal.  Choose, with the left 
and right arrow keys, between Private, Friends and Public.  These designations are particularly 
useful in synchronization with the popular journal host LiveJournal, which will be discussed later. 
      
Finally, arrow down one last time to select, with your left and right arrow keys, the Mood you'd like 
to associate with this journal.  Again, this option is commonly associated with LiveJournal, and 
you may skip it if you wish.  When you're done selecting all the parameters for your journal entry, 
press the OK key and your entry will be saved.      

Finding Entries 
Option 3 within the Program Menu allows you to jump to any date to look for entries under that 
date.  Once you've selected this option, simply enter two digits for the day, two for the month, and 
four for the year of your target date, and press OK.  You will be positioned at the date you entered 
and informed whether there are any existing entries for this day, and you can resume normal 
movement within the calendar.      



Enabling Synchronization and Uploading Entries 
Option 4 within the Program Menu is Synchronization.  Currently, the Icon supports 
synchronization only with LiveJournal.  When you have chosen Synchronization, you will be 
presented with one option, Add Journal or Blog Account.  Select this option and you will be 
presented with another single option, Existing LiveJournal Account.  Selecting this option will 
present you with a form where you may enter your LiveJournal (or LJ) user name, down arrow, 
enter your LJ password, and press the OK key to add your account to the Icon. 
      
Now, when you return to the Synchronization option, you will be presented with a single option 
reflecting your personal LiveJournal account.  Selecting this item will present you with the options 
to (1) synchronize or (2) remove the account from your Icon.   
      
Make sure you are connected to the Internet before choosing Synchronize.  Selecting this option 
will do two things: the Icon will update the LiveJournal server with any entries you have created 
on the Icon, complete with their time, date, privacy level and mood; and the Icon will retrieve your 
LiveJournal entries from the server and place them into your journal calendar for offline perusal.    
Stay tuned for software updates to bring synchronization support to other popular blogging and 
journal hosts     
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The Utilities Menu 
Settings 
The first item in the Utilities Menu is Settings. You may access this by navigating to the Utilities 
Menu and selecting the first option or by typing 6, 1 from the applications Menu. You will be 
presented with a menu containing 4 settings categories, each of which opens a dialog when 
selected. After adjusting the settings in any dialog, press the OK key to save your changes, or the 
Cancel key to return to the settings menu without changing anything. 

General Settings 
The first item in the Settings Menu is General Settings. Use the up and down arrows to move 
through the various settings in the dialog, and the left and right arrows to move through the 
options for each setting. The first item in the General Settings dialog controls how long the Icon 
waits to automatically shut off after inactivity. By default this is set to 5 minutes, but you may also 
choose 10 minutes, 30 minutes, or never, in which case, Icon will never shut off unless you shut it 
down manually. Remember that, if you choose never, and forget to shut Icon down, you may 
completely drain the battery and could loose unsaved data. 
  
The second item in the General settings dialog pertains to the sleep timer. You may find the sleep 
timer useful if you like to read or listen to music at night as it will ensure that the Icon does not 
continue reading or playing music too long after you have gone to sleep. By default the sleep 
timer is set to off. You may choose to set the timer to stop a continuous read or media playback 
after 15 minutes, 30 minutes, 45 minutes, 60 minutes, 75 minutes, 90 minutes, 105 minutes, or 
120 minutes. The sleep timer only stops the continuous read or media playback, it does not shut 
Icon off. After the sleep timer has stopped activity, the auto shut off setting described above will 
take effect. So, if your sleep timer is set for 45 minutes, and your auto shut off setting is set for 15 
minutes, reading or playback will cease after 45 minutes, but Icon will not shut down for another 
15 minutes. If playback or reading is restarted before auto shut off takes effect, the cycle will start 
over, and sleep timer will again cease activity in 45 minutes. 
  



The third and fourth items in this dialog have to do with inputting text. The character timeout 
setting allows you to control how long the Icon waits to pick up a character when texting through 
the telephone keypad. By default this is set to 1 second, but can be adjusted by 0.1 second 
intervals from 0.5 seconds to 2 seconds. The final item lets you choose whether you would like 
the Braille input method to be computer Braille (uncontracted or grade 1 Braille) or grade 2 Braille 
(contracted Braille). 

Menu Settings 
The second item in the Settings Menu lets you customize how menus operate on the Icon. The 
first item in this dialog is “Speak Menu Numbers?” and can be set to yes or no using the Select 
key as a toggle between the two. By default, Icon speaks menu numbers you navigate through 
menu items so that users can become familiar with the numeric shortcuts used to access them. 
However, once you have memorized these, you may no longer wish to hear them. Please note: 
even if menu numbers are not spoken, you can still use the numeric shortcuts to open programs 
or menus. 
  
The second item in this dialog is similar to the character timeout option in the General Settings 
dialog, but pertains to using numeric shortcuts in menus. This item allows you to set how long you 
want the Icon to wait before inputting a menu selection that requires multiple digits. By default, 
this is set to 1000 microseconds and may be adjusted using the left and right arrows. 
  
The final item in this dialog is a yes/no toggle controlled by the Select key that lets you choose to 
have the Icon remember your last menu item location. If you choose yes, when you enter a menu, 
the item you selected last time you were in that menu will be highlighted. By default, this is set to 
no. When set to no, Icon will place you at the top of each menu you enter. 

Speech Settings 
The third item in the Settings Menu lets you define the various voices Icon uses to indicate 
formatting attributes, e-mail replies, and elements of a webpage. The first option in this dialog is a 
global setting that controls key echo. Use the left and right arrows to move through the choices: 
none, characters, words, and words and characters. Below this are a number of definable voices 
for use in the Word Processor, E-mail, and Web Browser as well as a default voice. To move 
through the various voices, use the up and down arrows. To adjust the pitch of the highlighted 
voice, use the number 1 to lower and the number 3 to raise the pitch. To adjust the speech rate of 
the highlighted voice, use 4 for slower, and 6 for faster. Finally, use 7 and 9 to move through the 
various voice personalities available on Icon so that you may choose which personality you would 
like assigned to the highlighted voice. If you do not wish Icon to use separate voices for each 
element, you can set all the voices to the default by pressing the Menu key and choosing option 
1, Set all Voices to the default Voice.  

Time and Date Settings 
The fourth and final item in the Settings Menu is Time and Date Settings. Selecting this option will 
bring up the same dialog as does selecting the Time and Date line of the Status information. 
Setting the time and date has already been described in the section of the manual concerning the 
Info and status Center. 

File Explorer 
Option 2 from the Utilities Menu is the File Explorer.  You may use this application to review the 
files you have stored on the Icon, create and manage folders, and open, delete, and rename files 
on the system.  Remember that many of the files stored on the internal flash disk and the hard 
drive are essential to the operation of your Icon, so you should never delete or move a file you 
are unfamiliar with unless instructed to do so by technical support personnel.  In the event that 
you remove a file necessary to the operating system of the Icon, you will have to reload the Icon's 
software, and may experience loss of your data and settings. 



      
When you select the File Explorer from the Utilities menu, you will hear the message "Available 
Drives: Hard Drive."  This means that you are in the list of drives available on the Icon, with the 
30 GB hard drive highlighted.  Use the up and down arrow keys to move among the available 
drives.  The Internal Flash Disk should always be available, and if you have inserted a mini-SD 
card or connected a peripheral drive, these will show up as well. 
      
To access the contents of the highlighted drive, press the right arrow key.  As you navigate with 
your up and down arrow keys through the available files and folders on the drive you've selected, 
you will hear their names.  A name by itself represents a file, but if the Icon says "folder" after the 
name, you have highlighted a folder that contains other folders or files, and you may right arrow 
again to access its contents.  You can determine the size of any highlighted file by pressing the 
status key: at this point, the file name will be announced followed by its size, as measured in 
bytes. 
      
Pressing the right arrow key, or Select, on a file will launch the file.  If it is a document, it will open 
in the word processor; if it is audio content, it will launch in the Music Player.  Sometimes, when 
you are attempting to access a system file or a file type the Icon does not recognize, the Icon will 
fail to launch the file and will instead announce "I don't know how to open this file." 
      
Several options are available to you within the File Explorer's program menu.  You may choose to 
delete a file (option 2 from the Program Menu).  If you do this, the system will ask you if you are 
sure you really want to delete the file, and you may press OK to confirm or Cancel to abort the 
deletion.  You may use the * key, rather than entering the program menu, to quickly delete a file 
or folder.  Please note that there is no difference between the deletion confirmation for an 
ordinary file, such as a song or document, and a system file integral to your Icon's performance, 
so always exercise caution in choosing which files to delete. 
      
You may choose to rename the highlighted item by selecting option 3 from the Programs Menu.  
You will be prompted to enter a new name for the file or folder you've chosen.  After you do this, 
press the OK key and the name change will be completed.   
      
Option 6 within the Program Menu is Create Folder.  Use this option to create new folders to help 
you organize your files.  For example, you might set up a folder for each class you are taking 
during a particular semester, or a folder for audio recordings you make during a vacation.   Simply 
select Create Folder, enter a name for your new folder, and press OK.  Your folder will be created 
immediately, and you may start saving content there. 
      
You may select one or more files at a time to copy, move, open or delete.  To do this, highlight 
the file or folder you would like to select and then press the # (pound) key.  The file or folder that 
has been selected will be announced, and you will hear an echoing tone.  (Note: If you select an 
entire folder, all files within it will be selected.)  Whenever you navigate past a file or folder that 
you've selected, you will hear the echoing tone again.  Pressing the # (pound) key when you hear 
this echoing tone will remove the highlighted item from selection. 
      
Once you have selected one or more items, new options will appear in the Program Menu as 
follows.  Option 1, Open Selected, will launch all your selected files.  Option 2, Delete Selected, 
will delete all of your selections.  Option 4, Copy Selected Here, will create copies of all your 
selected files at the location you have currently highlighted.  Option 5, Move Selected Here, will 
remove all your selections from their present location and move them to the location you have 
currently highlighted.  Finally, option 7, Clear Selected, will undo all of your selections and leave 
you free to make new selections.      



Disk Drive Mode 
Option 3 from the Utilities Menu is Disk Drive Mode.  This application is used to connect the Icon 
to your PC in order to synchronize information or transfer files.  Before entering Disk Drive mode, 
ensure that your Icon is connected securely to the docking cable; and that the docking cable is 
securely connected, via USB, to your PC.  You should save your data and close other 
applications before attempting to enter Disk Drive Mode, because if the hard drive is busy with 
another application, the Icon will not be able to enter this mode.   
      
Once you've selected Disk Drive Mode, the Icon will say "Preparing to enter Disk Drive Mode" 
and, if activation of the mode is successful, "Disk Drive Mode ready."  Unlike other applications 
on the Icon, Disk Drive Mode will not allow other applications to function while it is running.  To 
leave Disk Drive mode, you must press Cancel and wait for the message "Exiting Disk Drive 
mode." 
     
 While the Icon is connected to your PC in Disk Drive Mode, it will show up in the My Computer 
utility (assuming that you are using Windows) as a removable disk.  You may use your PC to 
navigate through the Icon's folders and files, add media or book content, transfer documents, or 
check on the available storage space on your drives.  Please avoid altering or deleting system 
files (or any files you do not recognize as your own), or attempting to add new programs to the 
Icon, while in Disk Drive Mode.   
      
Always be sure to press Cancel on the Icon and wait for the "Exiting Disk Drive Mode" message 
before disconnecting the Icon from your PC.  Following this procedure will make sure that the 
Icon has successfully finished any data transfers and synchronizations before the connection is 
broken.  Ending the connection while the Icon and your PC are still communicating makes you 
vulnerable to data loss and corruption.        

Bluetooth Control Panel 
The Bluetooth Control Panel, option 4 from the Utilities menu, is a simple application that allows 
you to interface wirelessly with Bluetooth-compatible headsets and keyboards.  Like the Wireless 
Control Panel turns on the wireless radio when it launches, launching the Bluetooth Control Panel 
turns on the Bluetooth radio.  Remember that keeping Bluetooth on will cause your battery to 
drain more quickly than usual, so it is a good idea to disable the radio when you aren't using any 
Bluetooth devices. 
      
The first time you launch the Bluetooth Control Panel, the list of Bluetooth devices will be empty.  
Use option 1 from the Bluetooth Control Panel's Program Menu to find any Bluetooth devices 
within range of your Icon.  You will hear the message Finding Bluetooth Devices", followed by a 
snicking sound as the search is completed.  The message "Bluetooth Devices Found", combined 
with an ascending series of pops, will signify that the search is complete.  Any available devices 
will be displayed in a list which you may navigate with your up and down arrow keys; and you 
may connect to any item in this list by pressing OK.   
      
You may highlight any item in the list of active Bluetooth devices and end its pairing with the Icon 
by selecting Remove Bluetooth Device from the Program Menu.   
      
You may turn off the Bluetooth radio and close the Bluetooth Control Panel at any time by 
selecting option 2, Turn Bluetooth Off, from the Program Menu.      

Task Manager 
The Task Manager, which can most quickly be accessed by a one-second press of the 
Applications Menu key, was covered near the beginning of this manual.  It can be accessed 
directly from the Utilities Menu under option 5.      



Check for Software Updates  
Updating software on the Icon is easier than the update process on any competing device.  All 
you need is a wireless Internet connection and ten minutes.  Just select option 6, Check for 
Software Updates, from the Utilities menu, once you've made sure that you're connected to the 
Internet.  The Icon will say "checking for software updates."  If you are running the latest version 
of the software, the Icon will report "No software updates available".  If,, however, there is a new 
version of the software available for download, the Icon will say the version number that is 
available, and give you two options: 1 to download the software and 2 to hear it described.  If you 
choose option 2, listen to the description and then press Cancel to return to the software update 
menu.  Selecting option 1 will launch the software update process.  The Icon will ask you to close 
any active applications, save your work, and press OK when you're ready to continue with the 
update.  Once the update begins, the Icon will keep you updated on its process through the use 
of speech prompts to let you know what tasks it is performing and also a swishing sound every 
few seconds as is present when downloading e-mail or updating periodicals, and will eventually 
restart on its own, running the newly downloaded version of your software. You can cancel the 
update at any time by pressing the Cancel Key.        

Backup 
Launch option 7, Backup, from the Utilities Menu, to save your Icon settings for later retrieval.  
When the backup application launches, you may either back up (save) your current settings, or 
arrow down to restore settings you have saved before.  This application is useful for saving 
settings for later restoration in case of loss of power to the system or a major upgrade; or for 
maintaining more than one group of settings for different purposes (e.g. editing a document with a 
special group of speech settings). 
      
Press Select on "Backup Current Application Data" to save your current settings.  You will be 
presented with a two-line dialog.  The first line is meant to contain a description of the settings 
you are saving.  You may either leave it blank or press select, enter your description, and press 
Cancel to return to the dialog.  The second line, accessed by pressing down arrow, automatically 
records the time and date of your backup.  You may review but not change this information.  
When you are ready to back up your settings, just press OK.  The Icon will announce "Backing up 
application data ... backup complete." 
      
If, from the main backup screen, you highlight the date of a previous backup, you may press 
Select to access the options referring to it.  You may choose option 1 to restore the backup.  You 
will be asked if you are sure you want to proceed with the restoration: press OK to confirm or 
Cancel to abort the operation.  Alternatively, you may choose option 2 to delete the backup.  In 
this case, too, you will be asked to choose whether you are sure.      

Report a Problem 
The Icon's developers are committed to keeping the software as up-to-date, responsive, and free 
of bugs as possible.  To meet this goal, they need to know when users experience a problem.  
With that in mind, the Levelstar team has developed a system for reporting problems unrivaled on 
any device in the adaptive technology market.  Reporting a problem will take a few moments of 
your time, but it will increase your chances of a satisfactory solution and will help the developers 
improve the Icon software. 
      
To report a problem, select option 8 from the Utilities menu.  The Icon will say "Report a problem" 
and ask for your name.  Please enter your first and last name so the developers will know who 
has sent in the report.  Then, down arrow to the line that says "Description", and press Select.  
Now you may enter a description of the problem you are having.  Since the OK key is used to 
start a new line, just as it does in any document, you must press Cancel when you're done 
entering the description of your trouble. 
      



As you continue to arrow down, you will pass the serial number and software version of your unit.  
You may not change these lines.  Below them, you will find first the current date and then the 
current time.  These should be correct, but if they are not, enter the current date and time as you 
would in the Set date and Time dialog. 
      
When you have filled out all the pertinent information about your problem, press the OK key.  The 
Icon will say "Creating Report" and then offer you a list of choices for handling the report.  You 
may (1) Place it in the Problems folder on the hard drive, or (2) send it to Levelstar via the 
Internet.  If you have a working Internet connection, choose option 2.  If you do not, you may 
choose Option 1, and retrieve the problem report by connecting the Icon to your PC and copying 
the problem report from the Problems folder of your hard drive.    You may then E-mail it to 
Levelstar using your PC.  For further instructions on handling problems when you do not have an 
Internet connection, please call Levelstar at (303) 926-4334.  
      
If you attempt to exit the Problem Report utility before completing your report, the Icon will ask 
you to decide whether you are sure you want to exit.  If you choose Yes, the problem report in 
progress will be lost.      

Console 
The Icon runs on a special version of Linux. Option 9, Console, within the Utilities menu, allows 
you to access the Linux command line and interact with the Icon on an advanced, non-menu 
driven level. You should access this option on your own ONLY if you understand how to interact 
with the Linux command line, since your actions within the Console may influence the regular 
Icon interface in unpredictable ways. For more information on the Console, contact the Icon 
developers. 
       
Warning! Levelstar provides the Console for advanced Linux users, but you enter it at your own 
risk. It is possible to modify the Icon's software through the Console in such a way that the 
software is corrupted. Consequences may include data loss and failure of the operating system. If 
your actions in the Console necessitate repair by Levelstar, that repair will not be covered under 
your warranty or maintenance agreement, so please use good judgment and extreme caution if 
you decide to use the Console. If you want to learn Linux, there are several books on Bookshare 
that will introduce you to it, and your safest option is to start learning on a PC with a Linux 
distribution installed. We do not recommend that beginners attempt to learn Linux using the 
Icon.      
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The Games Menu 
Currently, the only item in the Games Menu is Tic Tac Toe. To open it, navigate to the Games 
Menu and choose the first option, or type 7, 1 from the Applications Menu. When the game opens 
you will need to select your letter. Type 1 for x or 2 for o, or simply arrow to your desired letter 
and press select. The object of Tic Tac Toe is to get 3 of your letter in a row and to block your 
opponent from getting 3 in a row. Your row of 3 may be vertical, horizontal, or diagonal. 
  
The nine squares of the Tic Tac Toe board are represented by the numbers 1 through 9 on the 
telephone keypad. To place your letter in a square, press and hold the number of that square. 
Icon will confirm the row and column where you have placed your letter, and will counter with its 
own move, announcing the column and row where it placed it’s letter. If you forget what’s in a 
given square and want to check, press the number of that square quickly and Icon will tell you 
what letter is in that square. When a game is won by you or the Icon, or it reaches a stalemate, 
Icon will prompt you to press Cancel to quit or OK to play again. 
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Appendix A  
Icon Sync 
The Icon Synchronization Program lets you synchronize your Outlook calendar and contacts as 
well as you’re my Music folder with the Planner, Address Book, and Music folder on the Icon. 
Before you can synchronize, you must first install Icon Sync on your computer.  
  
Installation. 
1, Place the CD that came with your Icon in to the CD-rom drive of your computer and locate the 
Icon Synchronization Program folder. 2, Press enter to open the folder. 3, Select the setup.exe 
file and press enter to launch it. 4, Follow the prompts to accept or change the folder where the 
program is stored, and where the shortcuts will appear. To accept the defaults, simply tab to Next 
and press space or enter. 5, Review your installation options and tab to the Install Button and 
press space or enter. 6, Wait a few seconds for installation, press space or enter on the Finish 
Button when it appears.  
  
Synchronizing. 
Before launching Icon Sync from your computer, connect your Icon to the computer via the USB 
cable and place your Icon in Disk Drive Mode using the procedure described in the Utilities Menu 
section of this manual. Launch Icon Sync from your desktop. The program will open with a menu 
of 4 items.  The first 3 are check boxes which are checked by default. These items are 
Synchronize Planner, Synchronize Contacts, and Synchronize Music. You may uncheck any of 
the boxes by pressing the spacebar if you do not wish to have a particular item synchronized.  
  
The fourth item in the menu is the Synchronize Button. Press space or enter on this to 
start synchronization. When synchronization is complete, you will be placed back in the 
synchronization menu. You can then press Cancel on the Icon to exit Disk Drive Mode 
and unhook the Icon from the computer. 
  

Appendix B 
Troubleshooting 
  

Appendix C 
External Keyboard Functions 
When using an external keyboard, you may wish to know what keys map to Icon keys. 
    
Application Menu           F 10 
OK                               Enter 
Cancel                          Esc 
Select                           Space 
  
Function keys are also used as shortcuts for opening programs and for running the media player. 
Use f4 to open the Media Player, f5 to open the Word Processor,, and f6 to open the Planner. 
Use the first 3 function keys as system wide hotkeys for controlling the media player. This means 
that you can be anywhere in Icon and can use f1 to rewind if held down, or go back a track if 



pressed quickly; f2 to toggle pause and play, and f3 to fast forward if held down or move to next 
track if pressed quickly.      
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Co-located Radio Modules  
This co-located radio configuration has demonstrated compliance to FCC regulations.  
      
Caution * Use of this product meets the FCC requirements for radio frequency (RF) radiation 
exposure in the standard head and body configuration.  For body-worn applications, holster part # 
2600-00087 must be used to ensure RF exposure compliance, with a minimum 
separation distance of 1.2 cm. The maximum SAR value measured for head was 0.174 W/kg 
averaged over 1 gram.  The maximum SAR value measured for body was 0.096 W/kg averaged 
over 1 gram.   
      
           

FCC Compliance Statement 
NOTE:  This equipment has been tested and found to comply with the limits of a Class B digital 
device, pursuant to Part 15 of the FCC Rules.  These limits are designed to provide reasonable 
protection against harmful interference in a residential installation.  This equipment generates, 
uses and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications.  However, there is no 
guarantee that interference will not occur in a particular installation.  If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the 
equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures:  
•         Reorient or relocate the receiving antenna.  
•         Increase the separation between the equipment and receiver.  
•         Connect the equipment into an outlet or circuit different from that to which the receiver is 

connected.  
•         Consult the dealer or an experienced radio/TV technician for help.  

  
Changes or modifications to this unit not expressly approved by LevelStar, LLC could void the 
user's authority to operate this equipment 
           
LevelStar, LLC               
Icon Mobile Manager Model Number: EI-30 
Icon Braille Mobile Manager Model Number: IBP-30 
Braille+ Mobile Manager Model Number: EIB-30 
  
This device complies with Part 15 of the FCC Rules. 
Operation is subject to the following two conditions: 
1.  This device may not cause harmful interference, and     
2.  This device must accept any interference received, including interference that may cause 
undesired operation.      
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